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Chapter 1: Introduction 
Solitaire 950 Features  

 
Accepts existing system keycards and ID cards 
With Solitaire 950 from KABA, universities, hospitals and other large institutional  
or industrial complexes can economically increase the range of their existing electronic  
access control system. 

• By incorporating the existing User database with the Solitaire System 950 database, 
existing cards can be programmed to operate the locks. 

• Using your existing cards saves time and money.  

• Special keycards, usually Temporary User keycards and Maintenance keycards, can be 
encoded using the Solitaire 950 Low-C Encoder by KABA.   
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Encoding and Cards 

Solitaire 950 can now use two types of encoders: 

The Low-C (low-coercivity) swipe style encoder - encodes temporary keycards 
Certain master level keycards, and lock system maintenance keycards are all based on KABA ’s 
proprietary encoding scheme (not ABA standard encoding) for a higher level of security. 

• Low-C encoded keycards to be used as temporary user keycards or special keycards.   

• If you only have a Low-C encoder, you must use ABA format cards, supplied by the 
customer, for permanent keycards. 

How to Use:  Swipe the keycard through the slot in one smooth motion and wait until the green 
light signals that the encoding was successful.  

Note:  This encoder encodes Low-C temporary and special keycards only. 

 
The High-C (high coercivity) motorized encoder – encodes temporary keycards and 
permanent keycards as follows: 
• High-C encoded keycards to be used as temporary keycards.   

• ABA (American Banker’s Association) standard or ISO 7811-2 standard encoded keycards 
(on track 2 of the magstripe). Since these cards are credit-card type standard and very 
robust, they are perfect for use as permanent keycards. 

How to Use:  Insert the keycard into the slot in the motorized encoder and wait until the encoder 
pushes it out.  

Note:  This encoder encodes High-C temporary and High-C permanent keycards. 

The Solitaire 950 lock reads both High Coercivity (High-C) and Low Coercivity (Low-C) cards. 

 
Lock and Audit Capacity 
• Solitaire 950 lock capacity is a maximum of 1000 Users per lock. 

• Solitaire 950 shows up to 800 events per lock audit. 

Solitaire 970 Entrance Lock 
The Solitaire 970 Entrance Lock is mechanically different from the Solitaire 950 lock. The user 
has more manual control over the door because the 970 does not lock automatically.   When the 
user unlocks the door using a valid keycard, the door remains unlocked (in Passage Mode) until it 
is manually locked again using the deadbolt or a keycard – see below.  This feature prevents 
accidental lockouts and is helpful in emergencies. The Solitaire 970 lock has two modes of 
operation: 

Lock mode 
The lock unlocks when a valid keycard is swiped through the lock and the outside lever is 
depressed. 

Passage mode 
The lock allows entry without a keycard when the outside lever is depressed. The lock is set to 
passage mode every time the inside lever is depressed. To set the lock back to lock mode, simply 
project the deadbolt from the inside or swipe a valid keycard through the lock on the outside. A 
user inside the room would project the deadbolt to ensure that no one could enter. A user leaving 
a room equipped with the Solitaire 970 Entrance Lock would close the door, then swipe his/her 
card through the lock to lock the door. 
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Lock Audits 

Note that, for Solitaire 970 Entrance Locks, the report will indicate whether a keycard was used to 
unlock the door or the interior lever was used to unlock the door and set the lock to passage 
mode. For information on how to audit and download data from the lock, see Lock Audits, 
Reports in Chapter 6 Using the Maintenance Unit. 

Database Migration 

Solitaire 950 also has an option allowing you to input Users' profile data directly into the system 
(instead of manually typing in all the IDs and names) by importing User profile related data items.  

• You can import a database (formatted as a standard ASCII text format file) from anywhere on 
your network.  

• Some data may be imported via diskette.  The database cannot be too large (more than 
about 1.5 MB) and it must be formatted as a standard ASCII text format file.  

• This same type of database information can also be exported directly to a location on your 
network, or via a diskette.  

Time Management 

• There are 16 timezones, 14 of which are programmable.  

• Each timezone has 4 intervals, which may include weekends, weekdays, holidays or vacation 
blocks. 

Online Help 

Online Help for the Solitaire 950 describes its features and functionality and also provides the 
procedures to set up and maintain the system. 

Navigating the Help 
The Help screen is divided into two panels, the topic information on the right and a narrower 
panel on the left that shows you the Table of Contents or the Index depending on which tab you 
click. Choose the index tab to search for key words and phrases and the Contents tab to search 
for book and topic titles. 

The quickest way to find help is to look at the Table of Contents shown in the left-hand panel of 
the Help screen.  Click on the specific topic you need help on. If you don't know the exact topic 
title, choose the Index tab and click on any keyword, which might apply to the topic. 

To go to specific help topics: 
1. Click on the Contents tab in the panel on the left. You will see the Table of Contents, which 

shows Book and Page icons. 

2. To view the book's contents, double-click on the book and a list of its pages is displayed. 

3. To go to the Help topic, double-click on the page for the topic you want to see. 

To find help on a topic without knowing the exact title: 
1. Click on the Index tab in the panel on the left and choose a keyword related to the topic. 

2. Type in the word or scroll down the list and double-click on the keyword and the topic will 
display or, if the keyword is used in different subjects, you will see a list of many topics. Click 
on the topic of your choice from the list and click on the Display button. The help topic you 
selected will appear. Here's an example of the list provided for the keyword "users". 
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For example, if you want to know how to Add Users, double click on the title or click Display and 
the Help topic will be displayed in the right hand panel, where Overview is displayed in the 
illustration below. 

 

Help Menu Bar 

 

The menu bar at the top of the Help screen offers these options: 

The Hide/Show button hides or shows the Table of Contents and Index. The navigation button 
goes back or forward through the Help. Print enables you print a topic or selection. The Options 
menu includes: Hide Tabs, Back, Forward, Home and Stop. "Stop” temporarily pauses any 
animation on the screen and stays on the topic you are viewing. To move on, select Refresh from 
the same Options menu. From Options, you can also adjust your Internet browser settings. 

Button Icons 

The buttons from the Solitaire 950 software are used as a quick reference graphic at the 
beginning of each Help topic. By glancing at the button graphic you can tell what the topic relates 
to. 
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Reports 

 

Master and Special Keycards 

 

Timezone 

 

Administrator Profiles 

 

Access Groups 

 

Locks 

 

Upload to MU 

 

Start MU 

 

Download from MU 

 

Reset Encoder 

 

Encoding 

   

 

Words, phrases and titles appearing in a different color with an underline are links to other topics.  
They are known as hyperlinks. Double clicking on these will display the topic. To return to where 
you were, keep clicking the Back button to page backwards to where you want to be. 

Note that the link changes color when you select it. You can click on it and review the topic as 
many times as you wish. 

See explanations of the different keycard encoding buttons with High-C and Low-C encoders on 
pages 8 and 9. 



Solitaire 950 User Manual 

6    PK 2828 02/05 

 
Graphics in Online Help 
Pictures of screens are provided in the Help only so that you can verify that you are looking at the 
correct screen in the Solitaire 950. They are not interactive. In Solitaire 950, all the main screens 
have tool tips to define each field on the screen.  

The Solitaire 950 offers many prompts and warnings at each step of the way while you are 
configuring your system, so it's nearly impossible to make a really drastic error such as deleting 
all Users and doors 

Printing online Help 
To print a single topic: Click the print icon to print the single topic currently being displayed. 

 Note:  Underlined text indicates hypertext links that pop up or jump to additional information. The 
hypertext does not print with the topic. In addition, some graphics may not print completely the 
way they appear on screen. 

Tool Tips 

In Solitaire 950, all the main screens have tool tips to define each field on the screen. A tool tip is 
what you see when you let your cursor hover over a Tab, title, or any type of information field. 
The cursor changes to a pointing hand and the explanation of the field appears in a box. 
Sometimes a tool tip also tells you what to do with the data provided in the field, for example, 
"Click the left mouse button to display the User Group." In the illustration below, the field 
description reads, "Clears all fields to create a NEW User. When you have completed entering 
your data, press the update button." 

 

 

Reading these tool tip messages tells you exactly what is required for each entry, so that you 
don't need to refer to the Help too often. 
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Terminology in Solitaire 950  

When using Solitaire 950, you will deal with the terms explained below. 

Security Levels  
An administrator is someone authorized to use Solitaire 950. Administrators must have a 
password and a defined administrator level. The Master Administrator can assign up to 15 
passwords at one of the four access levels to the system. We recommend having only one 
Master Administrator per site and assigning all other tasks to the three levels of administrators 
except for the changing of Facility IDs, which can only be done by the Master Administrator. 

Master Administrator 
The highest Security Level. The Master Administrator creates all levels of Administrator, including 
another Master Administrator. The Master Administrator can do all of the following: 

• Set or change the Facility ID. (Note: Only the Master Administrator can do this) 

• Create and remove other Master Administrators  

• Create Users, Doors, User Groups and Access Groups. 

• Assign User access 

• Handle the importing of databases 

Make Special and Temporary User keycards  

• Produce reports 

• Program and audit locks  

Level 1 Administrator 
(One level below Master Administrator) can perform ALL Solitaire 950 functions except the 
following: 

§ Cannot create other administrators or change the Facility ID. 

Level 2 Administrator 
 Can do everything that a Level 1 administrator does except the following: 

§ Cannot encode special keycards such as emergency, emergency cancel, lockout or lockout 
reset cards. 

Level 3 Administrator 
Can do everything that a Level 2 administrator does except the following 

§ Cannot encode keycards 

To see how to designate Users as types of administrators, see the procedure for Create 
Administrators.  

Note: When you first install Solitaire 950 software, using a default User name and password 
lets the installer log on to the software. You then create another User and change him/her 
into a Master Administrator. After at least one Master Administrator is created through the 
software, a valid logon is required before anyone can get into the system. The 
recommendation is that you create only one Master Administrator. In fact if you try to create 
more than two, you receive the following warning: 



Solitaire 950 User Manual 

8    PK 2828 02/05 

     

 

Access Groups   
Users who are grouped together solely on the basis of having access to the same door or doors 
at the same time. An Access Group is really a collective timezone representing a timeslot during 
which the assigned Users can get in.  

• You can assign Users from all different User Groups and departments to the same 
Access Group. 

• You should give the Access Groups names which reflect 

•  the time of access  

• the Users likely to access the locks at that time.   

Access Group Timezone Definitions 
Access Groups, by default, will be assigned 24-hour access (in 48 blocks of 30-minute time slots, 
from 0 to 24 hours).  

Timezones (up to 14 are User-programmable) are created by an administrator and assigned to 
access groups. When Users are denied access because of their access group (for example, if 
their Access Group is Night Shift and they are trying to enter a lock during the day) the lock 
responds with a sequence of green, then red lights, and denies access. For more information on 
the various lock responses, see Lock Status Indicators.  

Keycard Encoding/ Buttons 

High-C Encoder 

 

1. Verify information on a keycard.  Click, insert keycard and receive a message as to the 
identity and type of keycard. 

2. Encode a temporary keycard.  Click, insert keycard and a temporary keycard is encoded. 

3. Encode a permanent keycard.  Click, insert keycard and a permanent keycard is encoded.  
This card can be encoded only on the High-C encoder. 

4. Encode a cancel keycard.  Click on this button, insert a keycard and a cancel keycard is 
encoded.  Cancel keycards only cancel temporary keycards.  
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Low-C Encoder 

Only the following three buttons appear. 

 

1. Encode only temporary keycards with a Low-C swipe encoder. 

2. Verify only temporary keycards with a Low-C swipe encoder. 

3. Encode Cancel keycards with a Low-C swipe encoder only to cancel temporary keycards. 

 

Clone User and Door Buttons 

  

Clone User 

Select a user, click on the button shown above at the left and the following panel appears. See 
page 53 for the procedure. 

 

Clone Door 

Select a door and click on the button shown at top right and the following screen appears.  See 
page 61 for the procedure. 

 

Deadbolt 
A lock with a physical deadbolt features a thumbturn on the inside of the door. The deadbolt is set 
by turning the thumbturn to the horizontal position. If the deadbolt is set this way, there are only 
three ways to gain access: 

• with an Emergency card 

• with a Resident User card 

• if the person on the inside retracts the deadbolt with the inside thumbturn.  
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When the deadbolt is retracted, the door returns to its normal mode and admission practices. See 
Lock Status Indicators and Keycard Status Indicators. 

See Enable a Deadbolt for information on how to program the software to enable the deadbolt. 

Default  
Default is the current setting or action taken by hardware or software if the User has not specified 
otherwise. Default for Solitaire 950 means a setting that is automatically present in the software 
until you change it. Default Expiry time, for example, is the time that is assigned to all encoded 
temporary keycards unless you change the time when encoding a specific card. Default Access 
Group, for another example, is the Access Group that all new Users are automatically assigned to 
until you go in and move them to other groups, using the procedure Assign Users to Access 
Groups.  

Doors  
A door is an access point that requires control. It may be an elevator, stairwell, parking gate or 
anything else that you want to restrict access to. The word "Door" is used for convenience. 

Lock Types 

 

• Card Reader - The swipe-style lock reads the keycard in a single pass from the top of the 
Reader Slot to the bottom. 

• Panic Device – A bar attached to a door, usually an exit door from an area or building. The 
bar responds to pressure by unlocking.  This is usually used for Fire and Emergency exits. 

Solitaire 970 Lock – 
The Solitaire 970 Entrance Lock is mechanically different from the Solitaire 950 lock. The user 
has more manual control over the door because the 970 does not lock automatically.   When the 
user unlocks the door using a valid keycard, the door remains unlocked (in Passage Mode) until it 
is manually locked again using the deadbolt or a keycard. 

Passage Mode 
Some doors need to have free passage during peak traffic hours of the day, for example, doors 
that give access to bathrooms or cafeterias. In these cases, the locks have a special passage 
mode option. When a lock is in passage mode, anyone can open the door (no keycard is 
needed). Any lock can be programmed to have passage mode start and end times. The lock is 
put into passage mode manually by turning the thumbturn, swiping the keycard, or automatically 
(in the case of the Solitaire 970).  

Passage Mode for the Solitaire 970 Entrance Lock 
For convenience, the Solitaire 970 Entrance Lock is set to passage mode each time the interior lever is 
depressed. When the lock is in passage mode, anyone can gain access by depressing the outside lever (no 
keycard is needed). The lock can be easily set back to lock mode by projecting the deadbolt (on the inside) 
or by swiping a valid User, Resident User or Emergency keycard through the lock on the outside. 

Profiles  
A User Profile or Door Profile is the record of information you enter or import from a database, 
which is then kept in the program's database. Each time you change some information in a profile 
and update that information it is saved in the database. 

Resident 
A Resident User has special privileges in controlling the lock. The Resident User can place the 
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lock into Passage Mode.   With certain locks in certain configurations, he may be able to lock out 
other Users, except for fellow Residents.  See Resident Lockout below.  
A User may be assigned Resident status for more than one location, and a location may have 
more than one Resident User. For information on assigning Resident status, see Add a Resident.  

Resident Lockout 
Resident Lockout is one privilege of being a Resident User, depending on the type of lock and 
how it is programmed by the software.  If the Residents have the type of lock that can be 
configured for Resident Lockout, they can lock out all Users except fellow Residents.   The 
Resident Lockout can be cancelled by any of the Residents in that lock. See the section Resident 
Lockout. 

Resident Lockout for the Solitaire 970 Entrance Lock 
For the Solitaire 970 Entrance Lock, the Resident User keycard will not place the lock in resident 
lockout mode. However, if the deadbolt is projected manually, the Resident User keycard will be 
able to override it. 

Sites 
Sites are the locations of groups of doors. A site could be a building, a city, town, campus, 
hospital etc.  

Timezones 
Access groups and doors have timezones. A member of an access group has a timezone for 
when his/her card opens doors to which he/she is assigned. 

For timezones to be accurate, they must reflect the real time - Standard or Daylight Savings. 
When the change from Standard time to Daylight Savings occurs, you will receive a message on 
your screen: Similarly, you'll receive a message when the time changes from Daylight Savings 
back to Standard in the Fall. 

When you receive the message, you must go around to all the locks and swipe your Daylight 
Savings or Standard Time (Spring or Fall) card in each lock to set the time forward or back. 

Users  
Users are people who can open doors with assigned cards. Their ability to open certain doors at 
certain times is depends on the Access groups they belong to.  

User Groups 
User groups consist of Users who are grouped together. They may work for different 
departments, have different access groups, etc. but as group members they all have access to 
the same doors when the doors are assigned to a User Group. See Assign Doors to Users or 
User Groups and Assign Users to Access Groups.  A User Group is really a collection of 
doors.  The User’s access to his group’s set of doors depends on his/her Access Group. 
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General Windows Terminology 

The screen illustration below shows the basic terminology used in most Windows software to 
describe various types of menus, lists, and buttons.   

 

 

 

Main Menu 
Toolbar Menu 

Tabs 

Column Headings 

Selection Buttons 

Action Buttons 

 

Main Toolbar (or Main Menu Button Bar) 

 

 
In the Solitaire 950 application, when you let your cursor hover over each of these icons you will 
see a description of the action each button controls. These descriptions are called Tool Tips, see 
page 6.  
Each of these buttons allows you to enter a value and/or perform an action to set up your system. 
When you click on one of these icons, a dialog box appears so you can enter data. For example, 
clicking the Timezone button in the Main Menu Bar section brings up the dialog box shown on the 
next page. 
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Main Menu Bar: 

Lists the major categories of actions you can perform and the different actions in each category in 
a dropdown menu like this. 

.  

Pull the cursor down the menu to highlight the action you want. If you choose timezones, 
Vacations and Holidays, for example, a dialog box allowing you to configure these time elements 
appears. 

Listbox 
Shows a list of information that can be sorted by different headings.  In the picture above, you see 
a list of Users, sorted by the User last name.  For information on how to change this, see Sort 
Lists.  

Tabs 
Each tab gives you a different page with different fields.  In the picture above, you can see 6 
different pages of information: Users, User Groups and Doors in the upper tabs and Keys, Access 
and Profile in the lower set of three tabs.  All the procedures detailed in this Help tell you which 
Tabs to select to enter change or delete various combinations of information. 

Dialog Box 
Provides fields for data you want to enter in your system. You enter data to fill in the blanks, 
select a possible value from a list and/or perform an action, such as Save, Delete or Clear.  Some 

buttons, such the  button below open up other fields to select from - a dropdown 
menu or listbox. 

 

 

 

 

 

 
Grayed-Out Fields (not selectable or not available) 
When a field is grayed out, there are two possible reasons: 
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• There is only one choice, so the only possible selection is shown in the gray field.  In the 
example below, Card Reader is the device type, so Keycard is the only possible passage 
method.  It is shown in the grayed-out box. 

• The field is not available, so it is grayed out, preventing you from choosing it. In the 
example below, the Deadbolt field is grayed out because it is not available (it works only 
with the Device Type Lock, not Card Reader. 

 

 

 
Action Buttons: 

Action buttons can show words, such as the Save, Delete. New and Close buttons in the 
dialog box Timezones, Vacations and Holidays on the previous page. They can also show 
icons such as the two buttons in the picture of the large screen at the beginning of this 

topic,  and  representing "add a Resident to a door" and " delete a door 

assigned to this User". The Add or Move button  moves selected data (for example a 
User or door name) from a list on the right to a field on the left, such as shown in the screen 
below – moving data from Remaining User Groups to Assigned User Groups and Users. 
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Main Window 
.

 

Note: For this interface to work properly, it's important to select the category called small 
fonts when you set up your screen display. If you use large fonts, some of the dialog boxes 
will not fit on the screen and you may not be able to see some of your choices.   See View 
Options for instructions on how to choose small fonts. 

Functional Features 

The Solitaire 950 software is designed to run on Windows 98 SE, NT, 2000, XP Professional and 
Server 2003. All Solitaire 950 functions can be carried out on one PC provided it can be carried to 
the locks for programming and auditing. If you prefer a desktop PC for daily operations, you must 
have access to a portable PC for programming and auditing functions. 

Database/Lock Features 
 

• 1000 Users per lock, 100,000 lock capacity per system – 1million user capacity in system 

• 16 time zones (14 are User-programmable) and 18 holidays. 

• Four vacation blocks 

• Field-upgradeable software 

• Full search functions for large databases. 

• Audits of previous 800 transactions in a lock. 

• Reports sorted by many different criteria. 

• Ability to read a lock's current User and setup features. 
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Keycards 
• Master and Special keycard encoding encrypted and proprietary to KABA. 

• Ability to read a "lost" card showing all encoded ID data information. 

• Facility coding preventing unauthorized programming. 

• Users eligible for restricted or privileged access (Resident Users). 

• Emergency card overriding all time restrictions and lockouts. 

• Temporary lockout of all User cards. 

Batteries 
• Easy-to-replace 4 AA batteries lasting for approximately 100,000 openings. 

• Green and red lights flashing simultaneously indicate low battery when User card is inserted 
in lock. 

Ease of Use 
• Values for time zones, holidays, facility codes, etc. are fully configurable to satisfy any 

custom requirements. 

• Online Help provides complete configuration procedures.  

System PC 

The system PC is used for the following: 

• Maintaining the User database - adding, deleting, and modifying the lists of Users and 
doors. 

• Maintaining the door database - adding, deleting, and modifying the locations (sites, 
rooms, doors). 

• Assigning access - linking the User database and the door database 

• Encoding User Keycards and Special Keycards 

• Creating reports - sorting User, location, access, and audit trail data to view on screen or 
to print out hard copies for record keeping 

• Using utilities - system configuration, backing up the databases. 

You must be an administrator to use the Solitaire 950 software on the system PC. 
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System Requirements - General 

PC/MU system (Separate or Integrated) 
The Separate system is defined as a tabletop PC (for maintaining the database and encoding 
keycards) and a separate laptop PC (for uploading information such as access rights to the doors 
and downloading audit trail information).  

Separate 
"Separate" means there are two separate physical units - a tabletop and a laptop.  In terms of 
software, however, the complete Solitaire 950 software must be installed on the tabletop PC, 
using the KABA installation CD.  Then, insert the installation CD into the laptop PC and select the 
partial installation of the Maintenance Unit software only on the laptop. 

    

  

    

 

Integrated PC/MU system –  

Integrated means only one computer is required.  The requirements are the same as for the 
Separate system main (tabletop) computer. This single computer is usually a laptop so it can be 
carried around to the locks. The complete Solitaire 950 software must be installed on the laptop 
PC, using the KABA ILCO installation CD. 

Requirements 

System requirements vary widely depending on the size of your database and the number of 
transactions you perform daily.  Transactions are all the activities you perform in the Solitaire 950, 
such as adding Users, adding doors, creating access groups, timezones, etc.  

Installations with large databases (for example, 50,000 Users/5,000 locks) may require a PC with 
higher speed and more memory than the systems described below.  If you use an SQL server, 
add the RAM requirements for it to the Solitaire 950 requirements. 

Separate System PC - a Pentium 166 MHz, or better, tabletop PC with the following features: 

RAM - required for Solitaire 950 (using MSDE).  Remember these requirements vary with the size 
of your database.  The Recommended and Optimum amounts refer to large and very large 
databases. 

• Minimum: 32 MB 

• Recommended: 64 MB 

• Optimum: 128 MB 

• RAM - add amount required for SQL server (in addition to Solitaire requirements listed 
above) if you use an SQL server. 

• One nine-pin (DB-9) serial port and one parallel port 

• SVGA video card and SVGA color monitor  

• 100 MB or larger hard disk, 4 GB recommended for very large databases  

• Recommended that 50% of hard disk be kept free at all times. 

• CD-ROM drive  

 Full 950 Installation                                                                                                                                                                      

Install M-Unit 
only 
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• Diskette disk drive 

• Any IBM compatible printer 

• Windows 98 SE, NT, 2000, XP Professional and Server 2003 

• Explorer 4.0 or higher for the online Help. 

And 

• Separate Maintenance Unit (MU) - a Pentium 133MHz, or better, notebook compatible 
PC equipped with the following features. 

• 32 MB of RAM as an absolute minimum, 64 MB recommended 

• One nine-pin (DB-9) serial port and one parallel port 

• SVGA video card and SVGA color monitor  

• 50 MB or bigger hard disk 

• CD-ROM Drive 

• Diskette disk drive 

• Any IBM compatible printer 

• Windows 98 SE, NT, 2000, XP Professional and Server 2003. 

OR 

The Integrated PC/MU system –  

May be used instead of the Separate system - only one computer is required.  The requirements 
are the same as for the Separate system main (tabletop) computer.  This single computer is 
usually a laptop so it can be carried around to the locks. 

PC - a Pentium 166 MHz, or better, laptop PC with the following features: 

• RAM - MB of RAM required for Solitaire 950 (using MSDE).  Remember these 
requirements vary with the size of your database.  The Recommended and Optimum 
amounts refer to large and very large databases. 

• Minimum: 32 MB 

• Recommended: 64 MB 

• Optimum: 128 MB 

• RAM - add what is required for SQL server (in addition to Solitaire requirements listed 
above). 

• One serial port and one parallel port 

• SVGA video card and SVGA color monitor  

• 100 MB or larger hard disk, 4 GB recommended for very large databases  

• Recommended that 50% of hard disk be kept free. 

• CD-ROM drive 

• Any IBM compatible printer 

• Windows 98 SE, NT, 2000, XP Professional and Server. 

• Explorer 4.0 or higher for the online Help. 
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Keycard - Test 

Two test Keycards are shipped with the Solitaire 950 software. After the physical installation of 
the lock is complete, use the test keycard to verify that the lock is operational. 

Purpose: To test the lock immediately after installation, but before programming. 

Required: Acts as a construction key. The keycard will open any door at the site as long as the 
doors are not programmed. Once construction is complete and the locks are all programmed this 
card is invalid. 

Lock Response: One green flash and one red flash at the same time, followed by a green flash, 
then rapid flashing green, meaning access is granted. 

Expiry: Discard when all locks are programmed 

For information on Lock Response, see Keycard Status Indicators.  

 
Resetting Lock Date and Time 
Whenever the Battery power to a lock is interrupted (for example when the battery is changed) 
the date and time in the lock must be reset to the current date and time, since this information is 
lost to the volatile memory.  
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Chapter 2: Getting Started 
A major difference between the Solitaire 950 and the previous System 900 is that the 950 is 
configured and managed entirely through a Windows interface. Even if you have not used a 
Windows-type interface before, you will find many steps are understandable just by reading the 
screens. The online Help provides step-by-step procedures for setting up all the elements of your 
security access system. 

To get the maximum benefit from the online help, ensure that you know how to use it properly by 
reading the topic Solitaire 950 Online Help.  

Note: For this interface to work properly, it is important to select only the font type called 
“small fonts” when you set up your screen display. If you use large fonts, some of the dialog 
boxes will not fit on the screen and you may not be able to see some of your choices.  See 
View Options on page 32 to find out how to do this. 

Installing the Solitaire 950 

1. Insert the Compact Disk into the CD-ROM drive of your PC. 

2. The installation instructions will appear on your screen. 

3. When the installation is nearly complete, the program will re-boot your system in order for the 
installation to be final. Leave the CD-ROM in the PC during the re-boot. 

4. There may be waiting periods during the installation that will seem too long, but PLEASE BE 
PATIENT AND DO NOT TOUCH YOUR PC. The program will inform you when it completely 
finished installing Solitaire 950. 

When the installation is complete, proceed with one of the methods given below. 

Two Ways to Begin Using Solitaire 950 

A special program lets you import Users directly from System 900 into Solitaire 950 through the 
Database Utility. However, you cannot retain their Administrator levels, Resident status, or 
access. You must create NEW Master Administrators and all the other levels of administrators - 
Levels 1, 2, and 3. Of course, you can use the same names and information but, because it is a 
new system, the administrators must be re-designated to their positions. 
 We recommend you import your database first and set one of your Users as a Master 
Administrator. However, you could start with the Log on procedure and import your database after 
you have created a new Master Administrator. 

Follow the procedure for importing a database given below. 

New Database 
If you are building a new database, start with the Logging On to the Solitaire 950 Application 
procedure given on page 24 of this manual. 

Facility ID 
The Facility ID is a number assigned to your facility (building or group of buildings) by the Master 
Administrator. It can be any number between 1 and 999999 and it is used in combination with the 
encrypted number supplied by KABA ILCO with the software. This combination creates a unique 
number. The Facility ID number is assigned in the dialog box for Setting up a Workstation on 
page 30.   

• If you import your System 900 database FIRST, you will have the same facility ID by default.  

• If you build a new database from scratch, a FACTORY DEFAULT ID will appear, which you 
can change to your own ID. 
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Note:  WHENEVER THE FACILITY ID IS CHANGED EVERY SINGLE LOCK IN THE 
SYSTEM MUST BE RE-PROGRAMMED. It is important; therefore, to have only one Master 
Administrator set the ID before configuring anything else and to always keep that ID. 

WARNING:  MAKE SURE YOU HAVE A CURRENT BACKUP OF YOUR SYSTEM 900 
DATABASE before you import it into Solitaire 950. 

WARNING: When you import the System 900 database into Solitaire 950, all doors are set 
as being updated (they appear with green lights). Therefore, BEFORE YOU IMPORT THE 
DATABASE, MAKE A NOTE OF ALL DOORS THAT NEED TO BE UPDATED so you can 
carry out the update in the Solitaire 950. Remember if you don't write down which doors 
need to be updated and the data they need you will lose that information. 

HOW DO I IMPORT ASCII FILES? 
For information on the database structure of System 900 ASCII files refer to the Annex. Install 

Solitaire 950 from your installation CD following the procedure on page 21. 

1. Click on Windows Start icon on your PC. 

 

2. Select Programs, then Solitaire 950. 

3. Select the DB Utilities icon from your Solitaire 950 group of menu choices click on it. 

 

The following login dialog box appears: 

 

 

4. Log in with KABA ILCO (KABA as name and ILCO as password) if you have not already 
created a database of Users with assigned passwords OR log in with the name of the Master 
Administrator you created after logging in to the Solitaire 950. The logo below tells you are in 
the database utility. 
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5. From the Main Menu button bar click on the Import ASCII database.  

 

The following window appears: 

 

Note: An ASCII file may have the extension .txt but it can also have any extension you 
choose. In this case, it's a good idea to label database files, like the “. dat “above, for 
example, to remind you that it is a data file 

File Formats 
The information needed by the Solitaire database is User ID Last Name, First Name and 
Sequence Number. There are two basic types of data formats: alphanumeric and numeric.  Since 
the size of the record fields is static, the fields have to be filled with some character in case the 
data inside is smaller than the maximum value. For alphanumeric types, spaces must be 
appended after the data (ex. Edmund....  ) and for numeric types, zeroes must precede the data 
(ex. ....0032).  The ASCII files formatted for import must be created by your database 
administrator and placed in a so that you can import them into the Solitaire 950 database. 

For the detailed explanation on how to create these import.dat ASCII files - information required 
by your Database Administrator, see File Format Information for Database Administrators in the 
Annex to this manual.  

• Select the file to import and a title for the log file. Select Display Log if you wish. 

• Click on Import. 

When the import is complete, you will see messages like the ones below if you have selected 
Display Log. 
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Open the Solitaire 950 application, and you will see that the ASCII files you imported are now 
added to your list of Users. 

The ASCII files that you import must be updated daily by your administrator to ensure that you 
have the latest changes to Users, doors, etc. available. 

HOW DO I MIGRATE A SYSTEM 900 DATABASE? 
Install Solitaire 950 from your installation CD as in the procedure on page 21. 

1. Click on Windows Start icon on your PC. 

 

2. Select Programs, then Solitaire 950. 

Select the DB Utilities icon from your Solitaire 950 group of menu choices click on it. 

 
 

The following login dialog box appears: 
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3. Log in with KABA ILCO (KABA as name and ILCO as password) if you have not already 
created a database of Users with assigned passwords OR log in with the name of the Master 
Administrator you created after logging in to the Solitaire 950. The logo below tells you are in 
the database utility. 

 
 

From the Main Menu button bar click on the Import Solitaire System 900 database icon 

  

The following dialog box appears: 
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4. Select Display Log if you want to see the log of the conversion processes. 

5. Click on . 

You will see the following log describing the action as it occurs. The process may take time. If you 
have a slower computer or a large database, please be patient and wait till the process is 
complete. 

 

During the time that the utility is importing the data, you will see a message asking you to wait 
until the process is complete. 

6.  When the process is complete, the following message appears in the bottom field of the 
dialog box. 
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7.  Click on OK after you see a message informing you that the import process has terminated. 

Note: If you are upgrading from a previous KABA product (Solitaire System 900, for 
example) you may import your database with all its users. However, you cannot import 
administrators. You must create NEW Master Administrators and all the other levels of 
administrators - Levels 1, 2, and 3. Of course you may use the same names and information 
but because it is a new system, the Administrators must be re-designated to their positions. 

 

Logging on to Solitaire 950 

After installation, the Solitaire 950 login dialog box appears. 

 
 

 First, log in using "KABA" as the name and "ILCO" as the password; it MUST be upper case. 

1. You are now in the Solitaire 950 application. Notice that there are Users in the List of Users in 
the top panel of your screen if you have imported a database from Solitaire 900. 

2. After you have created the first User, you can continue with the other procedures for creating 
Doors, User Groups, timezones etc. 
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OR 
you can change the first User to an Administrator (Master Administrator) right away by 
following the procedure in How do I Create an  Administrator on page 71.  

Note: You only have the choice of creating a Master Administrator. The other selections in 
the dropdown menu, Level 1, Level 2 and Level 3 Administrator are grayed out.  

If you haven't imported a database, create the first User by following the procedure below. 

 

Create Initial User 

HOW DO I CREATE THE INITIAL USER? 
In the initial screen for Solitaire 950, the toolbar and most menu choices are grayed out, as 
shown below. 

 

 
You cannot do anything in the Solitaire 950 until you have at least one User in the database. 
Creating this User allows you to configure the system with doors, timezones, more Users, etc. 
You can change your first User to a Master Administrator right away follow the procedure in 
Create Administrators. or wait until after you have configured your system.  

Note: At this stage, you only have the choice of creating a Master Administrator. The other 
selections in the dropdown menu, Level 1 and Level 2 Administrators are grayed out. 

1. Select the Users tab on the upper panel  

2. Select the Profile tab on the lower panel  

3. Enter the new user's information in the fields provided on the Registration, Reference and 
Personal Info tabs. 

Note: You must enter the user’s first and last name, and a user ID. The user ID is numeric 
and it can be any number over zero that is not already taken by another user. The information 
provided in the Reference and Personal Info tabs is optional. 

4. Accept the defaults, which appear in the other fields - User Group and Timezone. There is no 
choice because you haven't yet created User Groups, Access Groups, Timezones, etc. 

5. Enter the department name if you wish. 
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6. Enter the new User's Profile information in the fields provided. The Registration, Reference 
and Personal Info tabs can contain optional information. 

 
 

Accept the defaults that appear in the other fields - User Group and Access Group. There is no 
choice because you haven't yet created User Groups, Access Groups, Timezones. 

7. Click on the Update button , the middle button of the three on the right to save the 
information on the new user. 

8. The new User appears in the list of Users at the top of the User panel. 
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Set Up Workstation 

HOW DO I SET UP A WORKSTATION? 
Choosing Options from the Main Menu, then Settings>Workstation allows you to configure the 
system for defaults. 

 
 

General Options 

Facility ID 
The facility ID is a number assigned to your facility (building or group of buildings) by the Master 
Administrator. It can be any number between 1 and 999999 and it is used in combination with the 
encrypted number supplied by KABA with the software. If you import your System 900 database 
FIRST, you will have the same facility ID by default. If you build a new database from scratch, a 
factory default ID will appear, which you can change to your own ID. 

Note: It is important to have only one Master Administrator set the ID.  If too many people 
have the power to change the ID, there is a risk of the number being changed inadvertently.  
This creates a lot of unnecessary work, because WHENEVER THE FACILITY ID IS 
CHANGED EVERY SINGLE LOCK IN THE SYSTEM MUST BE RE-PROGRAMMED.  

Tool Tip Activation 
Use the check boxes to activate the Tool Tips (the text boxes explaining fields and suggesting 
actions) and the reader/encoder. 
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Reader/Encoder 
Select the type of encoder you are using with the Solitaire 950 system.  

 

Encoders 
Low C swiped:  Encodes Low-coercivity keycards.  Encoder is less expensive; keycards retain 
information for a shorter period of time. Encodes temporary user keycards only. 

High C motorized: Encodes High-coercivity keycards; Encoder is more expensive but keycards 
retain information for longer periods of time. Encodes either permanent or temporary user/special 
keycards. 

Note: The reader/encoder should appear activated (not grayed out). On some computers a 
re-boot may be required. Restart your computer if the encoder button is grayed out. For this 
interface to work properly, it's important to select only small fonts when you set up your 
screen display. If you use large fonts, some of the dialog boxes will not fit on the screen and 
you may not be able to see some of your choices.  Refer to Sort Lists for information on how 
to do this. 

Database Integrity 
This field is on the General tab of the page for Set Up Workstation.  Select Yes or No to order the 
system to check database integrity each time you close the application.  It is always a good idea 
to perform this function, which verifies the users and doors in the system to ensure that 
everything is synchronized.  However, if you have a very large database it could take up to five 
minutes to execute this task.  Clients with large databases might want to select No but perhaps 
select Yes at scheduled intervals to preserve the accuracy of the database. 

COM port 
Select the COM port to use for the encoder.  The default is COM 1. 

M-Unit Update Method  
Choose Direct if you want to enter new data directly into the M-Unit or Diskette if you want to 
transfer new data on to a diskette. 
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Refer to page 124 for information on the two programming methods. 

Set up sorting options on start-up 
Select the criteria for sorting user and door lists.  These can be changed at any time. 

VIEW OPTIONS - HOW DO I CHANGE MY SCREEN SETTINGS? 
1. From the main menu, select Options>Setup. 

 
 

2. To change background colors and textures, choose the Set background textures item. 

3. To see the toolbar (Main Menu Button Bar described in Windows Terminology) select View 
Toolbar. 

 
 

4. To see messages about the status of your system, including number of Users and doors, 
select View Status Bar.  

 

5. You should see messages like the following at the bottom of your window: 

 

Note:  It’s important to set up your screen display to use the font category called “small 
fonts”.  Using large fonts may make the dialog boxes too large so that some of the choices 
will not be seen.  Screen fonts are selectable in Windows applications by clicking on Start, 
then choosing Settings\Control Panel\Display and then selecting the Settings tab, as shown 
below. Choose Small Fonts in the dropdown listbox called Font Size.  
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HOW DO I CREATE LIST-SORTING DEFAULTS? 
Select how you want your User and door lists sorted - by name, number etc. This is a default 
preference you are choosing here. 

From the main menu, select Options, then Set Up>Workstation. The Configuration Window dialog 
box appears. 

    

The bottom panel of this dialog box allows you to select the defaults for how you want lists 
sorted. For example, you may choose the default here of viewing a list of Users sorted by 
last name and it will always come up on screen like the example below, alphabetically by 
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last name. Remember that this is only the default setting. You can sort lists by just 
clicking on the different column headings when you are looking at them or entering data. 

 

If you want to see the Users by Identification Number, click on Ident and you will see the 
following: 

 

The heading disappears when you click on it and is replaced by. . See Find a User 
for more examples of sorting lists and finding information using column headings. 
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Keycard Data Format Encoding 

Once your system is configured you can customize it and "fine-tune" it more by changing some of 
the default settings. However, in the case of Keycard format, you set the position and length of 
the field only once.  No further changes are required - all keycards keep the same format. 

HOW DO I CREATE KEYCARD DATA FORMAT DEFAULTS? 
1. From the main menu, select Options, then Set Up>Workstation.  

2. The Configuration Window dialog box appears. 

 

3. Scroll to the right until you can see the Keycard Data Format tab and click on it. The 
screen appears as below: 

 

 



Solitaire 950 User Manual 

36    PK 2828 02/05 

4. Ensure that your encoder is plugged in and connected to the COM port of your PC. (You 
may have to re-activate the encoder with the encoder button from the main menu button 
bar.) If not, have one of your facility's ABA cards ready. 

5. Click on the Read Keycard button. 

6. You see the keycard cartoon asking you to insert a valid card. 

7. Swipe/insert your ABA card through the encoder, and the card number should appear in 
the Current Keycard Read box as shown below. 

  

8. Find your User ID number. Determine what the start position is and what the length of the 
number is. 

9. For example, if your ID no is 0169 out of that string of numbers, then enter the number as 
starting in the 6th position and having 4 digits. The number then appears to the right as 
000000169, which is correct. 

Note: Start counting the position from the first NUMBER that appears; ignore any letters. 

10. So, if 6th position, 4-digit length is correct, then click on Save Definition and all future 
cards will be read using this data format for User ID, and showing User ID only.  The 
remaining digits are all zeroes.  

Format Encoding for Facility ID and Card Count 

1. Return to the Keycard Data Format tab, and select User ID, Facility ID and Card Count. 

2. Select a start position and length of field for Facility ID and Card Count.  There must be 
no overlapping of positions – for example, if your User ID number starts in the 6th 
position and runs for 4 digits, the Facility ID number cannot start before position 11 (6+4 
=10). 

3. If you enter a number like 8, you will see the following message: 
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For the example illustrated, we select Facility ID to start in 11th position and run for 6 digits.  
The number would be: 000000. 

 

When you are sure all data fields are correct, insert a new keycard and click on Read 
Keycard. The following appears. 

 

You have now configured the default Keycard Data Format settings. 
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Note:  Unused numbers are merely discarded.  There is no need to use all the numbers. 

Solitaire 950 LEDs  

The LEDs on the electronic lock flash in a certain sequence, depending on the situation. 
These charts give the LED flash patterns when the lock is set in different modes 

LED INDICATOR FLASH MEANING 
After battery connection 
no light 

The thumbturn is in the passage mode 
position. 

Single red within 4 seconds The thumbturn is in the locked position. 

Still red Battery is low. 

Thumbturn is turned (for Passage Mode) 
 
Single green The lock is put into passage mode. 

Single red The lock is set back to locked mode. 

 The lock stays in the locked mode in the 
following cases: 

 
Passage Mode is disabled 

 
Deadbolt is projected 

Thumbturn is turned (for deadbolt) 
Single green Deadbolt lockout is removed.    

Single red Deadbolt lockout is set (passage mode is 
removed if it exists). 

Lock Failure 
Single red every second Lock has failed 

  

Solitaire 970 for Windows LEDs  
LED INDICATOR FLASH MEANING 
Still red Battery is low. 

Inside lever is depressed (for Passage Mode) 
 
Single green 1) The lock is put into passage mode. 

2) Deadbolt Lockout is removed 

Thumbturn is turned (for Deadbolt)  

Single red 1) Deadbolt is projected 
2) Passage Mode is removed 
3) The lock is set back to locked mode. 

Lock Failure  

Single red continuously 
Lock has failed 
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Chapter 3: Users, Doors and Timezones 
Create User and Door Defaults 

Default settings enable you to create a standard database quickly by providing automatically 
assigned settings for Users, Doors, User Groups etc. Once your system is configured you 
can customize it by changing some of the default settings. 

HOW DO I CREATE USER AND DOOR DEFAULTS? 
1. From the main menu, select Options, then Settings>Workstation. The Configuration 

Window dialog box appears. 

2. Click on the Users and Doors tab. 

 

 

 

3. Only the Temporary User Group appears on the dropdown list. The Temporary User Group is 
just a “holding area” where new Users will be kept until you assign them to another group.  
The other information - city, state/province etc. that you fill in will also apply to new User 
groups. 

Note 1: When you begin creating other Users, they will be placed in that group until you 
create other groups and are able to move them to these other groups. Because Temporary 
User Group is just a holding area, it cannot be assigned to a door and it cannot be deleted, 
since you must always have at least one User group in the system. 

Note 2: You cannot select a door site, device type or timezone from the dropdown lists. The 
choices are grayed out because you have not created any so far. When you have created at 
least one of each, enable your preferred defaults here and they will be applied every time 
you create a new door, site or device type. 

When all the default values are filled in, click the Enable Defaults check box at the bottom 
left of the dialog box. You have now configured the default User and Door settings. 
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Create Defaults for Expiries and Timers 

HOW DO I SET THE DEFAULT EXPIRY FOR TEMPORARY KEYCARDS? 

1. From the main menu, select Options, then Setup>Workstation. The Configuration Window 
dialog box appears. 

 

2. Select the Expiries and Timers tab. 

3. From the dropdown menu box for Days, type in (or scroll up or down to) the number of days 
that you want to pass before the Temporary User keycard expires.  
OR 
Click on the ellipse button to the right of the Days field and a calendar will drop down.  Select 
the expiry date from the calendar. 

 

4. In the example above, the User will have 3 days (before his/her temporary card expires.  

5. After you've entered the number of days, the exact date and time of the card's expiry appears 
to the left of the box. Click OK and the default expiry date is set. 
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HOW DO I SET TIME PERIODS FOR SYSTEM FEATURES? 
This Set Up Workstation dialog box is also used to set timers for system activity logs, audit logs 
and other features shown in the illustration below. 

 

1. Set the Auto Logoff for the system. The Auto Logoff feature means that if the system is idle, it 
will shut down after a set amount of time has elapsed. Use the counter or just enter the 
number, 300 minutes in the example above. 

2. Set the Lock Shutdown Time for the lock.   

Note:  Lock Shutdown Time sets the amount of time after which the lock will shut down 
completely (even for Users with valid cards) if there have been more than 7 invalid attempts 
to open the lock.  These attempts could have been made using an invalid card, during an 
invalid timezone or for whatever reason.  This lock shutdown is a safety feature that permits 
the lock to shut down completely until you have found the reason for the invalid access 
attempts. If you don’t want this feature, set the lock shutdown time to "no shutdown. “Set the 
time for the system to keep audit logs and System Activity Logs.  You can set a maximum of 
365 days for each category.  

When the times have been set, the following actions take place: 

When the system starts up, it purges: 

• All System Activity Logs older than the selected time period (ex. 60 days.) 

• All Lock Audits Logs older than 60 days 

Note:  There is a function called Database Cleanup that allows you to manually purge the 
records whenever you want.  It also allows you to purge Temporary Keycard and Master and 
Special Keycard History.  See page 153. 

Select Yes or No for Display System Time Change Warning.   
• If you select Yes, a popup advising you that the time has changed and all doors must be re-

programmed will appear every time the time changes, even if it is only a few seconds.  This 
can be very annoying if you are on a network because the server continuously tries to 
synchronize the times. 

• If you select No, the popups will not appear automatically. 
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You have now set 

• Default expiry dates for temporary cards 

• Lock shutdown time – a security measure to make a lock temporarily inaccessible 

• Auto-logoff time - an amount of idle time after which the system will logoff. 

• A time period for system activity logs and audit logs to record actions. 

• Turning on or off the automatic popups for notification of any time change in the system. 

 

Create Timezones, Vacations and Holidays 

A lock can be programmed to have a 24-hour access timezone, no access timezone, or any other 
timezone (up to 14 timezones may be User-programmed). When Users cannot enter because 
their access group timezone does not correspond to the door's timezone the lock responds with a 
sequence of green, then red lights, and denies access. For more information on the various lock 
responses, see Lock Status Indicators.  

Note: Door Timezones for Solitaire 970 Entrance Lock 
Do not create timezones for doors with Solitaire 970 Entrance locks.  Remember that with 
these locks, the door enters Passage Mode Automatically when the inside lever is 
depressed 

HOW DO I CREATE A TIMEZONE? 
5. From the System Administration Menu, select Timezones, Vacations and Holidays or use the 

Timezones  button. 

 

 

6. Click on  to create a new timezone. 

7. Enter the name of your timezone in the Timezone Name field. Use a name that helps you to 
remember the real time, such as “Standard” referring to the usual 8:00 to 5:00 (17:00) 
working hours. 
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8. Set the start and end times for the days that you want your new “Standard" timezone to 
apply. 

9. Use the toggle buttons (up and down arrows) to increase or decrease the time by half-hour 
increments. (In the example above, the timezone called Standard means that the doors are 
openable from 8:00 to 17:00 on weekdays five days a week and 8:00 to 15:00 on weekends 
and holidays. Click the save button at the bottom to save the Standard Timezone. 

§ You have successfully created a new timezone. 

§ To modify a timezone, select an existing timezone from the dropdown list called 
Timezone Name and modify the hours or holidays following the procedure above, then 
save. 

§ To remove a timezone, follow the procedure called Delete Timezones on page 49. 

 

Vacations and Holidays 

Each timezone has four different programmable segments.  This means there are also four 
possible different vacation entries - one for each segment of the timezone. 

Note:  When Vacation is selected, Users' cards will not work in their assigned doors during 
that time period.  Vacations and Holidays are set in the Vacation and Holiday tabs of the 
timezone dialog box.  In the example below, Users in Access Groups with the Standard 
timezone (office staff, for example) come into work Mon. to Fri. from 8:00 to 17:00.  They can 
also work weekends or holidays from 8:00 to 15:00.  They are not forced to take their 
Vacation during Plant Shutdown (as the plant workers are).  The Plant Shutdown vacation is 
not selected (has no check mark) in the vacation submenu for the Monday-to-Friday part of 
their timezone. 
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However, as shown again below, during Plant Shutdown they cannot work on weekends.  So, we 
see that a timezone's vacation periods can be programmed differently for each of its segments. 

 

HOW DO I CREATE VACATIONS AND HOLIDAYS? 
1. Click on the Vacations Tab. 

2. The following dialog box appears: 
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3. Click on  and enter the name of the new vacation period, Plant Shutdown, for 
example. 

4. Click on the dropdown menu for Start Date/Time and a calendar appears as below: 

 

5. Use the  and  to go back and forward in months. 

6. Select the start date for the vacation period and then do the same to select the end date. 

7. When both dates are entered, save the vacation and remember that you will now reprogram 
all affected doors so that they will be closed during this period. 

 

9. A message appears: 
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8. Click on the Holiday tab. 

9. The following dialog box appears: 

 

10. Click  and enter the name of the new holiday. 

11. Select the date from the dropdown calendar as shown below.  

 

12. Click Save and you will receive a message that the holiday was saved successfully. 

You have now configured Timezones, Vacations and Holidays in your database.  
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Delete Timezones 

HOW DO I DELETE A TIMEZONE? 

 

1. Select the timezone from the dropdown list of timezone names at the top right of the dialog 
box. 

2. Click Delete - the middle button at the bottom. 

3. You have now deleted the timezone. 

Add a Site 

HOW DO I ADD A SITE? 
1. Select the Doors tab.  Select the Profile tab. . 

2. In the Profile tab, click on the square button with dots. This button is to the right of the 
dropdown menu of Sites. 

 

 The Site Names dialog box appears: 
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3. Type in the new site name and click Add. 

4. The new site then appears in the dropdown menu of sites in the Profile panel. 

 

You have successfully created a new site. To remove a site, delete all doors from the site, 
following the procedure in Delete Doors on page 64, and then follow the procedure Delete a Site 
below. 

 

Delete a Site 

HOW DO I DELETE A SITE? 
1. First, delete all doors from the site by following the procedure in Delete Doors on page 64. 

2. Select the Door tab . 

3. Select the Profile tab . 

4. In the Profile tab, click on the square button to the right of the dropdown menu of Sites. 

 

5. The Site Names dialog box appears: 
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6. Select the site name and click Delete. 

7. If you have not deleted all doors from the site you will see this warning: 

 

8. If you have deleted all doors, the site disappears from the dropdown menu of sites in the 
Profile panel. 

You have successfully deleted a site.  

Add Users 

HOW DO I ADD A USER? 

1. Select the Users tab on the upper panel . 

2. Select the Profile tab on the lower panel  

3. In the Profile tab of the Users window, click the top button  on the right to clear all 
fields and create a new User. 
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Note: This Clear action does not delete that User from your database. It just removes the 
information from the fields so you can type in the new data. 

4. Enter the new User's information in the fields provided on the Registration, Reference and 
Personal Info tabs. 

Note: You must enter the User’s first and last name, and a User ID. The User ID is numeric 
only, and can be any number over zero that is not already taken by another User. If you 
mistakenly enter a number, which is assigned to another User, you receive a message:  and 
you must change the number. The information provided in the Reference and Personal Info 
tabs is optional. 

 

5. Accept the defaults, which appear in the other fields - User Group, for example, - or select 
other values from the dropdown list. Enter the department name if you wish. 

 

6. Click on the Update button  the middle button of the three on the right. 

7. The new User appears on the list of Users. 

 

You have successfully added a new User. 
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Clone a User 

Sometimes you want to create several new users with the access groups, user groups, resident 
privileges, etc. as users that already exist. Rather than create each new user and enter all the 
access groups etc., you can copy the settings of an existing user and save them under a new 
user name with a different ID. The user will be an exact clone of the one you copied from in terms 
of access.  

HOW DO I CLONE A USER? 
1. Select the Users tab on the upper panel. 

2. Select the Profile tab on the lower panel. 

3. Select the user whose settings you want to clone to create a new user, checking that the 
Access settings are correct. 

 

4. Click on the Clone user button . 

The following dialog box appears. 

 

 

5. Select the new user ID in one of three ways: 



Solitaire 950 User Manual 

54    PK 2828 02/05 

• Type in an ID number for the new user who will be a clone of the user Mary Ellen Carter, 

• Click on  to see the next available user ID number until you find one you 
want. 

OR 

Swipe/insert a permanent user keycard through the encoder and the new user will take on the 
User ID from that card.  

6. Click on OK. 

The new user appears on the list of users. 

 

You have successfully created a new user with settings copied from an old user. Now you can 
simply change the name of the user as shown below. 
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Find a User 

HOW DO I FIND A USER? 
Finding a User in the Solitaire 950 is not difficult, even if your database contains thousands of 
Users. 

1. Select the Users tab . The list of Users appears in the top panel. 

2. Click on one of the column heads of the User List. 

 

3. Type the User’s first name, last name, ID or department in the appropriate column head. The 
list will scroll down to show the User’s name, ID or department highlighted on the list.  

 

4. Click on the selected (highlighted) User to confirm your selection. The typing in the column 
head disappears and the new name appears as Selected User. 

5. Select the Profile tab. 

6. Now you can view the User’s settings, change them and update them, or delete the User. 
Remember that the tabs labeled Reference and Personal Info are optional. You might want to 
enter this additional information if two of your Users have the same name, for example. 
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Delete Users 

You can delete the permanent user’s access from the database, as described below, and then 
create a new M-Unit file. Upload it to the M-Unit and program the locks.  

HOW DO I DELETE A USER? 
1. Select the Users tab . 

2. Select the User you want to delete. 

 

3. Select the Profile tab.  

4. Click the Delete User button  - the bottom button at the right of the Profiles panel. 

 

The program will ask you to confirm your choice with the confirmation request below. 

 

5. Click Yes and you have successfully deleted the User. The name will disappear from the list 
of Users.  
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Create Doors 

HOW DO I CREATE A DOOR? 
1. Select the Door tab.  

2. Select the Profile tab.  

3. In the Profile section of the Door panel, click on the top button of the three buttons 

 to create a new door. This clears all fields and allows you to enter the new name, 
etc. 

4. Fill in the name and location of the new door. 

5. Enter the floor, section and area of the new door.  

6. Do not forget to choose the correct type of device: lock, reader, or panic device from the 
dropdown list in the Device Type box on the right. 

 

7. Accept the defaults, which appear in the other fields, or change them by selecting 
another item from the dropdown lists for each field you want to change. 

8. Enable Deadbolt and/or Passage Mode. The deadbolt option is only available if your 
device type is Lock. Otherwise it is grayed out. 

If you enable Passage Mode, enter the time and day settings. 

Note: Solitaire 970 Entrance Lock  
When creating a door for the Solitaire 970 Entrance Lock, do not enable the passage mode 
setting, as the lock will enter passage mode automatically when the inside lever is 
depressed. 

9. Click on the Update button, t. 

10. The new door appears in the list of doors at the top of the Door panel. 
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You have successfully created a new door.  

To remove a door, see the procedure for Delete Doors on page 64. 

To find a door quickly, click on the heading of what you want to search by (for example Door ID) 
and type in the name of the door.   

See Sort Lists for more information. 

Note: When you enter the device type of the door, Passage Mode options may be restricted 
accordingly. For example, when you enter Lock as the device type (as in the example on the 
previous page), you have the option of selecting thumbturn or keycard as your passage 
method when the door is in Passage Mode. However, if you select Card Reader, as in the 
illustration below, the passage method is grayed out because there is no thumbturn, so you 
are restricted to keycard only - you cannot choose another method. 

 

 

 

Set Passage Mode 

Some doors need to have free passage during peak traffic hours of the day, for example, doors 
that give access to bathrooms or cafeterias. In these cases, the locks have a special passage 
mode option. When a lock is in passage mode, anyone can open the door (no keycard is 
needed). Any lock can be programmed to have passage mode start and end times. The lock is 
put into Passage Mode manually by turning the thumbturn 

Solitaire 970 Entrance Lock 

Note: The Passage Mode setting, defined when you create a door, does not affect the 
functioning of the Solitaire 970 Entrance Lock. The lock is automatically set to passage 
mode whenever the inside lever is depressed. When you create a door, as described in 
Create Doors in chapter 3 Users, Doors and Timezones, do not enable this setting for the 
Solitaire 970 lock. 
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HOW DO I SET PASSAGE MODE? 
For the procedure for programming Passage Mode, see Create Doors on page 57. 

 

 

 

Effects of Passage Mode 

• All Users will be able to enter the door by just turning the handle during the hours defined for 
Passage Mode. 

• If the deadbolt is projected while the lock is in passage mode, passage mode is cancelled. 

• Passage mode is cancelled when the lock is re-programmed. 

The lock cannot be put into the passage mode between the PASG-END time of the current day 
and the PASG-START time of the next day. In other words, the lock will never enter passage 
mode after the programmed PASG-END time; a valid keycard will be required to gain access. 
Also, the lock cannot be programmed for a period of longer than 24 hours. The following warning 
appears: 

 

 

Every time you flip the thumbturn from the locked to the passage position or vice versa, you have 
to wait up to four seconds for the desired mode to take effect. A single green flash indicates that 
you are entering the passage mode. A single red flash indicates that you are going back to the 
locked mode.  See Keycard Status Indicators. 
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Enable a Deadbolt 

If the deadbolt is enabled, there are only three ways to gain access: 

• With an Emergency card 

• With a Resident User card (see page 64). 

• If the person on the inside retracts the deadbolt by turning the thumbturn. When the 
deadbolt is retracted, the door returns to its normal mode and admission practices.  See 
Lock Status Indicators and Keycard Status Indicators for information on indications for 
deadbolt lockouts. 

• The lock is programmed by the software. The lock on any door may be set to Deadbolt 
Enabled,  (as in the last of the three illustrations below).  This option only applies to locks 
equipped with deadbolts.  

� When you enter the device type of the door, deadbolt options may be restricted 
accordingly. 

� For example, when you enter Lock as the device type (as shown below), you have 
the option of selecting deadbolt enabled. 

 

However, if you select Card Reader as your lock type, the deadbolt is grayed out since you have 
no choice.   

 

Select Deadbolt if desired. 

See the procedure in Create Doors on page 57. 
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See Keycard Status Indicators for information on LED indications for deadbolt lockouts. 

Clone Doors 
Sometimes you want to create several new doors with the same location, lock type, etc. as doors 
that already exist. Rather than create each new door and manually enter all the other information, 
you can copy the settings of an existing door and save them under a new door name.  The door 
will be an exact clone of the one you copied from in terms of access.  

HOW DO I CLONE A DOOR? 
1. Select the Doors tab on the upper panel. 

2. Select the Profile tab on the lower panel. 

3. Select the door whose settings you want to clone to create a new door. 

 

4. Click on the Clone Door button . 
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The following dialog box appears. 

 

5. Enter a new name for the door. 

 

6. Click on OK. 

The new door appears on the list of doors. 

 

You have successfully created a new door with the settings copied from an existing door. 
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Find a Door 

HOW DO I FIND A DOOR? 

1.  Select the Doors tab . 

2. Click on Profile . 

3. Scroll through the list of doors to find the door you are looking for or type it in the column 
heading for Door Names. 

4. Select the door you are looking for by clicking on it or typing it in the column heading 
for Door Name. 

 

 

 

 

Now you can simply view the door's settings, or you can create or delete a door. For these 
procedures, see Create Doors on page 57 and Delete Doors on page 64. 
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Delete Doors 

HOW DO I DELETE A DOOR? 

1. Select the Door tab . 

2. Select the Profile tab . 

 

3. In the List of doors at the top of the door tab window, click on the door you want to delete. 

4. Click on the delete button,  

5. A confirmation request appears as below: 

 

7. If you choose Yes, the door disappears from the list of doors at the top of the Door panel. 

6. Clicking No will cancel the door deletion. 

Note: If you plan to delete an entire Site from the system, you must delete all doors from that 
site first.   See Delete a Site on page 50. 

Resident User 

� A Resident User has special privileges in controlling the lock. The Resident User can 
place the lock into Passage Mode and override a deadbolt.   With certain locks in certain 
configurations, he may be able to lock out other Users, except for fellow Residents.  See 
Resident Lockout below.  

� A User may be assigned Resident status for more than one location, and a location may 
have more than one Resident User. 

Resident Lockout 
Resident Lockout is one privilege of being a Resident User, depending on the type of lock and 
how it is configured the software, see table on page 68.  If they are resident in the type of lock 
that can be configured for Resident Lockout, they can lock out all Users except fellow Residents.   
The Resident Lockout can be cancelled by any of the Residents in that lock. 

Solitaire 970 Entrance Lock 
You can create a Resident User in a Solitaire 970 Entrance Lock if you wish. For the Solitaire 970 
Entrance Lock, the Resident Users will not be able to place the lock in Resident Lockout mode. 
However, they will still be able to override the deadbolt. 
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Add a Resident 

HOW DO I MAKE A USER RESIDENT IN A DOOR? 

1. Select the Users tab.  

2. Select the Access Tab.  

3. From the list of Users in the top panel, select the User you want to assign Resident access 
to. 

 

4. The names of the selected User's User Group and Access Group appear in the Access panel 
below as well as the list of doors which that group has access to. 

 

5. If the door you want is not on the list, highlight the door on the List of Entire System Doors on 
the right (see illustration below) and add it by clicking on the add/move arrow icon. 
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6. Select the door where you want the selected user to be Resident. 

7. Do one of the following: 

• Click on the Resident icon on the bottom left of the panel. . 

• Double-click on the user’s name. 

The following confirmation request appears. 

: 

6. Click Yes.  

You have successfully made the current User a Resident on that door. 

 

 

Note: The information about a door in which a User is Resident is highlighted in a different 
color. To remove a Resident from a door, follow the procedure on page 69. 
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HOW DOES A RESIDENT PLACE THE LOCK IN PASSAGE 
MODE? 
1. Ensure that the lock is configured in the software for Passage Mode.  Passage Mode is 

selected as part of the procedure Create Doors on page 57. Make sure that the settings are 
Lock and Keycard, as shown below. 

2. Ensure that you are within the Passage Mode part of the timezone - between the hours of 
7:30 and 16:30 from Monday to Friday in the example below. 

 

3. Ensure that you are a Resident on that door 

4. Swipe your card through the lock and wait the full six seconds of the flashing green light 
without turning the handle. 

5. Repeat Step 4. 

6. Now turn the handle, and you will see that the door unlocks to passage mode. 

7. To remove Passage Mode, repeat the same process.  After the second time of swiping the 
card and waiting the full six seconds, the door should lock again. 

Note: Only a User with a permanent User card and Resident status can put the lock into 
Passage Mode.  A temporary User card allows the Resident User to gain access to the door 
but does not allow him/her to set Passage Mode. 
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Resident Lockout 
In some cases, a Resident User may lock out other Users, in addition to being able to start 
Passage Mode and override the deadbolt on a lock. 

Resident Lockout can only be used on locks:  

§ of a certain physical type  

§ with certain passage mode and deadbolt options selected. 

This table provides an overview of the lock types and passage options that permit Resident 
Lockout. 

Resident Lockout – Possible Lock Configurations 
Lock 
Type 

Deadbolt Passage 
Mode 

Passage 
Method 

Start End Resident 
Lockout 

No No Not available Not available Not available Yes 

Yes No Not available Not available Not available Yes 

Yes Yes Keycard xx:xx xx:xx No 

Standard 
Lock 

No Yes Thumbturn xx:xx xx:xx Yes 

Not available No Not available Not available Not available No Panic 
Lock 

Not available Yes Keycard xx:xx xx:xx No 

Not available No Not available Not available Not available No Reader 

Not available Yes Keycard xx:xx xx:xx No 

 

Put a Lock into Resident Lockout 

The locks in your system that are configured for Resident Lockout can be put into Lockout Mode 
as follows: 

HOW DO I PUT A LOCK INTO RESIDENT LOCKOUT? 
1. Swipe your (the Resident’s) keycard through the lock (in a locked door) and wait for a full six 

seconds while the light is flashing green, without turning the handle. 
The lock will re-lock. 

2. The lock will flash red. 

3. The lock is now in Resident Lockout and only another Resident will be able to enter. 

A Resident in the same lock will be able to enter but after each entry of a fellow resident the 
lock reverts to its normal mode and non-Resident users will be able to enter. 
When a resident enters, he/she should observe that the lock is in Lockout mode and reset it when 
he/she leaves, assuming that the original resident that put it in Lockout Mode must have had a 
reason to do so. 
Warning:  It’s important never to leave a lock in Resident Lockout mode before 
programming it.  If the lock is left in that mode and you then re-program it, it will accept 
the new data but the Resident lockout will be unchanged.  The new users will not be able 
to enter. They will see green, red, and red flashes, indicating that the lock is in Resident 
Lockout Mode. Ensure that all locks to be programmed are taken out of Resident Lockout 
Mode.   
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Remove a Resident 

HOW DO I REMOVE A RESIDENT? 
1. Select the Users tab .  

2. From the list of Users in the top panel, select the User you want to remove Resident access 
from. 

 

Select the Access Tab . 

3. The selected User's list of doors he/she can access appears.  Doors where the User is 
resident are in a different color, like Dorval warehouse floor 1 on the list in the example 
below. 

.  

4. Select the door where the User is resident.  In the example above, Elizabeth Cooper is 
Resident in Dorval Warehouse.  

5. Click on the Resident icon. You will see the following message: 

 

6. Click Yes, and the door name (Dorval warehouse floor 1) will revert to the color of a regular 
User.  
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7. You have successfully removed Resident status on that door for the selected User. 

Note: The User’s Resident status is removed whether he/she is assigned as an individual or 
as a member of a User Group.  See How do I make a User Resident in a door? on page 
65.If you remove Door Access from a user, obviously you remove his/her Resident Status 
also.  See Delete Door Access from User and User Groups. 

If you change a User’s timezone in a door to Never, this will also removes his/her access to the 
door and thus his/her Resident status.  See Change User Access to an Individual Door. 
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Chapter 4:  Administrators, User Groups, and Access 
Groups 
 

Administrators 

HOW DO I CREATE AN ADMINISTRATOR? 
1. First, read the topic Security Levels. 

2. Follow the procedure for logging in to Solitaire 950. 

Note: If you are upgrading from a previous KABA product (System 900, for example) you 
may bring in your database with all its Users by following the procedure given in the 
Transferring Database section. However, you cannot retain their "administrator" status. You 
must create NEW Master Administrators and all the other levels of Administrators - Levels 1, 
2, and 3. Of course you may use the same names and information but because it is a new 
system, the Administrators must be re-designated to their positions. 

You are now in the Solitaire 950 application. Notice the List of Users in the top panel of your 
screen. 

3. From the top menu, select System Administration>Administrator Profiles or click on the 

Administrator Profiles button.  . The following dialog box appears: 

 

4. From the dropdown list of Users, select the User. 

Note: Only a Master Administrator can create other Level 1 Administrators. Therefore if you 
have an empty database and you have created your first User, following the procedure for 
Create User you must make that User a Master Administrator. The other levels, Levels 1, 2 
and 3 are grayed out at this point. 

5. Assign a password to the Master Administrator and confirm it. 
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6. Click Update to save your new Master Administrator. 

Note: If you forget to click Update and just click Exit you will see a reminder asking you if 
you want to save your changes. 

8. After clicking Update, you are prompted to log in again with your new password. 

Log in as "liz" (in the example below), the Master Administrator, with the Login name and 
password you assigned. 

 

9. If you don't already have a list of Users imported from a previous database, create some 
Users in the system, using the procedure Add Users.  

Note: You must have Users in the system before you can create other administrators. 

10. Click on the Administrator Profiles icon in the button bar  or select System 
Administration>Administrator Profiles from the Main menu. The Administrator Profiles dialog 
box appears again. 

11. Select the User (from the dropdown list of Users that you have imported or created) that you 
want to change to an administrator. 

12. Select the administrator level for this User from the dropdown list. The four administrator 
levels are now available: Master Administrator, Level 1 Administrator, Level 2 Administrator 
and Level 3 Administrator. 
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13. Each time you create an Administrator, assign a Login name and a password. 

Note: When entering information, avoid using symbols in names. For example, if an 
administrator named Mike O'Dell wants his Login ID to be his last name, it should be odell-
without an apostrophe. The apostrophe is an invalid character for names in Solitaire 950 
software. Dashes (-) and underscores (_) generally work fine. 

14. When you first install Solitaire 950 software, a default User name and password permit you to 
log on to the software. You then create another User and change him/her into a Master 
Administrator. After at least one Master Administrator is created through the software, a valid 
logon is required before anyone can get into the system. The recommendation is that you 
create only one Master Administrator. 

15. Click Update to save each Administrator profile. 

16. Click Exit to exit this window. 

17. You have successfully completed the procedure and you now have administrators. 

Note: If you try to create a third Master Administrator while there are two still in the system, 
you will receive the following message: 

 

18. Click Delete to delete an administrator.  

19. Follow the procedure in Delete Administrators below. You cannot delete or change the 
administrator level of the administrator currently using the system. The name of the present 
administrator is shown in the Current Administrator field.  Notice in the illustration below that 
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the Level is grayed out because you have selected the name of the current administrator. 

 

Delete an Administrator 

1. Click on the Administrator Profiles icon  in the button bar or select System 
Administration>Administrator Profiles from the Main menu. The Administrator Profiles dialog 
box appears. 

 

2. Select the Administrator that you want to delete. 

3. Click Delete to delete this administrator (Dina Davis in the example above). 

Note: If the person you want to delete is the current administrator, the Delete button will be 
grayed out because you cannot delete the current administrator. 
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4. Log out, and log in as another Administrator, then you can delete that person (Carmina 
Burana in the example above). 

5. Click Exit to exit this window. 

You have successfully completed the procedure to delete an Administrator. 

User Groups 

Create User Groups 

HOW DO I CREATE USER GROUPS? 
You must have a User Group already created in the system in order to have a place to put new 
Users. The Solitaire 950 opens with a pre-defined User group called Temporary User Group. 
When you begin creating other Users here, they will be placed in that group until you create other 
groups and are able to assign the Users to these other groups. Temporary User Group is just a 
holding area, so it cannot be assigned to a door and it cannot be deleted, since you must always 
have at least one holding area for new Users in the system. 

1. Select the User Group tab . 

2. Select the Profile tab  

3. The first User Group name (up to 25 characters) and description (up to 50 characters) on the 
list of User Groups appears by default in the name and description fields. If you have 
selected another User group, then that name appears in the field. 
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4. Click the top button on the right  to clear all fields so you can create a new User 
group. 

 

 

Note: This Clear action does not delete that group from your database. It just removes it 
from the fields so you can type in the new name. Notice that the clear and delete buttons are 
grayed out after you clear the fields, so you can only update after you have entered the new 
information. 

5. Enter the new User group name. Enter a description if you wish. 

6. Click the middle button on the right  to update the current User group record (save it 
to the database). 

7. The name and description of your new group appears on the list of User groups as below. 

 

You have successfully created a new User Group. 

To modify a User Group, select a User Group from the list, modify the fields in the Profile tab and 
update/save the information. The Temporary User Group cannot be modified or deleted. 
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Delete User Groups 

HOW DO I DELETE A USER GROUP? 

1. Select the User Group tab . 

2. Select the Profile tab . 

3. Select the User group you want to delete. 

4. Click the Delete User Group button  - the bottom button of the three at the right of 
the Profiles panel. 

 

5. The program will ask you to confirm your choice with the confirmation request below. 

 

6. Click Yes. 

7. If you have not removed all of the users from the group you will receive another message to 
tell you that they must be transferred: 

 

8. Move all the Users out of this group into other groups. See Assign Users to User Groups 
on page 78. 

Repeat this procedure, and you see the "Are you sure you want to remove (Group Name) again. 

9. Click OK and you have successfully deleted the User Group. The group’s name will 
disappear from the list of User Groups. 
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Assign Users to User Groups 

HOW DO I ASSIGN USERS TO USER GROUPS? 

1. Select (click on) the User Group tab on the upper panel.  

2. Highlight (single click) the User Group you want to assign Users to. 

 

3. Select the User tab on the lower panel. . 

 

4. The list on the left of the lower panel, Member Users, shows the Users already assigned to 
the selected User group. The list on the right, Other Users, shows all other Users in the 
system. The column, which is the criterion for sorting the list (Last Name), appears in a 

different color and this symbol appears in the column heading.   A block of 
Users can be selected by selecting the first one and holding down the Shift key. 

5. From the Other Users list, select the User/s you want to assign to the User Group. 

6. Click the add/move button . 

7. The User is now a member of the group you chose (Engineering) and the name appears on 
the Member Users list. Each time you add a new User to a group which has access to certain 
doors, remember that you must re-program the doors (locks) to accept that User, following 
the procedure in Program a Lock on page 126. 
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Note: Remember that the Temporary User Group is the one where all new Users are 
placed. When you begin creating other Users, they will be placed in that group until you 
create other groups and are able to move them to these other groups. The Temporary User 
Group is just a "holding" area, so it cannot be assigned to a door and it cannot be deleted, 
since you must always have at least one User group in the system. Users can also be 
assigned to User Groups when you create a User and fill in the User Profile. 

Assign a Default Access Group to a User Group 

Creating a default Access Group for each User Group saves time when you create a new user 
and select his/her User Group, or add an existing User to a User Group. 

You will have two options.  When the default group has been created you can: 

• leave the user automatically assigned to the default Access Group where most members of 
his/her User Group are assigned. 

• select another Access Group if this user requires different hours. 

Note: You can change the user's group by following the procedure Change a User's Access 
Group. 

HOW DO I ASSIGN A DEFAULT ACCESS GROUP TO A USER 
GROUP? 

1. Click on the tab  on the top panel and Profiles  on the bottom. 

The following screen appears: 
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The dropdown menu at the bottom of the panel gives you the chance to select a default 
Access Group to be used whenever you create a new user and add him/her to the selected 
User Group or move an existing user to that group. 

2. In the example above, we selected Production Day from the menu as the Access Group for 
new members of the User Group Shipping. 

3. Click on Update  to save this change, and Production Day is now the default Access 
Group for the Shipping User Group. 

4. When you create a new user and add him/her to this group, the user will have Access to the 
Group's doors only during the Production Day Access Group hours.   

If you forget the hours, click on the Access Group button  to see the timezone assigned 

to Production Day, (Day Shift) and then click on the Timezone  button and check on the 
hours for Day Shift timezone. 

5. If the User Group now needs access at a different time, (for example because of a shift 
change) select another Access Group from the dropdown menu, as in the example below and 

click on the update button . 

 

6 The Access Group changes to Night Shift and members in Shipping User Group can now 
only access their assigned doors during the Night Owl timezone.  

7 Any new users added to the Shipping User Group will automatically be assigned to the Night 
Shift Access group. 

8 To change a user 's access to just one door, see Change User Access to an Individual Door 
on page 98. 
Or,  

Go to the User  and  tabs and select an existing user or create a new user 
as shown in Add Users.  As soon as you select the User Group as Shipping, the Access Group 
Production Day automatically appears. 

To change it, select another Access Group from the dropdown menu and click on update 
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Now, the user Mary Ellen has a different Access Group from the rest of her User Group. 

 

To re-assign her to the Production Day Group, change in User/Profiles, as above, or by following 
the procedure in Change a User's Access Group on page 93 or the procedure in Change User 
Access to an Individual Door on page 98 if you just want to change her access to individual 
doors. 
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Doors 

Assign Doors to Users and User Groups 

Most Users and User groups have a pattern of access to certain doors.  Once you have assigned 
these doors to the groups, you will rarely need to change the entries.  However, if a User or User 
group changes its pattern and needs access to another door or set of doors, there are several 
ways you can change the access.  See Change a User's Access, Change User Group 
Assignments and Change User Access to an Individual Door for the procedures to use.  Access 
permission and time data are all stored in the lock, so the lock or locks must be re-programmed 
each time you change User or User group assignments. 

HOW DO I ASSIGN DOORS TO USERS AND USER GROUPS? 

1. Select the  tab on the upper panel. and select a door (Mar002, Marketing main 
office in the example below.) 

2. Select the Users tab  on the lower panel. 

 

3. The list of groups/individuals who already have access to the selected door is shown in the 
left-hand panel. 

4. In the right-hand pane of the lower panel, click in the box to the left of the User Group or User 
you want to move to give him/her access to Mar-002. 

5. Click on the add/move  arrow button to assign the User to the door access list on the left. 

Note: Doors and User Groups with boxes containing a + sign beside their names open up 
and show their contents when you click on the plus sign. When the contents are visible on a 
dropdown list, the + changes to a - sign. If a name appears with no checkbox and does not 
change when you click on it, that means that the group or door has no Users. 
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6. The door is now accessible to the selected User. The User appears on the door's current 
access list.  

Note:  A group that has been given access will appear containing all its Users. An individual 
User (for example, Raymond Chinaski, selected in the illustration above) appears at the top 
of the list called Specific Assignment because he was assigned to the door as an individual 
not as a member of a group. 

 

Delete Doors 

HOW DO I DELETE DOOR ACCESS FROM USERS AND USER 
GROUPS? 
Delete Door Access from a User Group 
1. To delete door access from a user group, select the user or user group on the door's access 

list on the left-hand panel.  

 

2. Click the Exclude button at the bottom of the panel at the left.  

3. You will receive a confirmation prompt so you have a chance to change your mind. 

For example, you would see the message below if you selected the User Group Admin from the 
selected door. 

 

4. Click on Yes if you want to exclude the whole group, No if you decide not to. 

Delete Door Access from Several Users in a User Group 
If you select the members of a User Group individually, as shown below, and then delete the 
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door, Warehouse, you will receive a confirmation request for deleting the door from each user 
individually.  

 

 

 

 

If you click on Yes for any of the users, they will now appear grayed-out and be excluded from 
access to that door but the other group members will continue to have access. In the example 
below, Chris Carter and Sam Spencer have been excluded. 

 

Delete Door Access from a Specifically Assigned User 
1. If a user has been specifically assigned to that door, but his/her group has NOT been 

assigned (like Raymond in the example below), and you select him and click on Delete Door   
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, the user loses access to that door.  

 

2. The user’s name re-appears in his/her group in the right-hand panel as shown below where 
Raymond Chinaski is now shown as a member of Engineering group on the list of Remaining 
User Groups. 

 

Delete Door Access from One User in a User Group 
What if a User is assigned to a door because he/she is a member of a group assigned to the 
door?  In the example below Mary Ellen has access to the door named Warehouse because her 
whole Group (Shipping) is assigned to that door.  In this case, the result of removing a door will 
be different. 

 

3. Remove her access by removing the door, that is, by clicking the box next to her name, and 
clicking the Exclude/Include Door button. 

4. You will receive this message: 
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5. Click Yes, and the name will become grayed-out as shown below.  The User Group Shipping 
still has access to the warehouse, but Mary Ellen no longer has any access to that door. 

 

Change User Group Assignments 

You may need to move a User or Users to another group because of a job change, for example. 
There are two ways to change a User from one User Group to another.  

HOW DO I CHANGE A USER'S GROUP? 
Method 1 
1. To change a User's User Group, click on the User tab on the top panel and Profile in the 

bottom panel.   

2. From the dropdown list in User Group, select the group that you want the selected User to 
belong to.  In the example below, imagine you want to change Carmina Burana from 
Marketing to Engineering. 

 

3. If you change the User Group of someone who is Resident on a door, you will see a message 
asking if you want to keep Resident status for that User even though she/he is placed in 
another group. 
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4. Click Remove or Keep and click "Apply to all items" if she has Resident status in several 
doors. 

5. In the example below, Carmina has been changed to the Engineering User Group. 

 

Method 2 
1. Click on the Users tab on the top panel and the Access tab on the bottom panel. 

2. Select a User from the list. 

3. Click on the User Group dropdown menu and select the group where you want to move the 
User, as shown below.  In the example below, you want to change Bob Bargan from Sales to 
Shipping. 

 

Now the change has been made: 
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Access Groups 

Access Groups  
An Access Group is really a collective timezone. Users from all different User groups and 
departments may be assigned to an Access Group.  An Access Group designates a timeslot 
during which the Users who have access to selected doors can get in.  

You should select Access Group names that reflect 

• the time of access  

 the Users likely to access the locks at that time.   

For example, "Evening Cleaners" would be a good name for a group composed of maintenance 
staff with working hours of 18:00 to 20:00.  However, if you had two researchers who needed to 
access the building and several doors at these hours, you could just assign them to this access 
group.  

An access "group" may be created for just one User, if this individual needs access at a certain 
special time. 

Access Group  Door A  Door B  Door C Door D 
Night Shift 
(24:00 to 5:00) 

X (Timezone – Never) X (Timezone – Never)  image3 

(Timezone 00:30 to 
5:00) 

(Timezone Always) 

Maintenance Staff  
18:00 to 23:00 

 (Timezone 17:30 to 
23:00) 

X (Timezone – Never) X (Timezone – Never)  (Timezone Always 

Office Staff 
8:00 to 17:00 

X (Timezone 00:30 to 
5:00) 

(Timezone 8:00 to 
17:00) 

X (Timezone 00:30 to 
5:00) 

 (Timezone Always 

If we look at the table above, showing three Access Groups and a random selection of doors in 
the System, Doors A through D, we can see some typical access patterns.   

The Night Shift Access Group  
• Cannot access Door A or Door B because doors have a timezone of Never for this group.  

Can access Doors C and D.  

• Door C: Night Shift can access Door C (except the first 30 minutes) because Night Shift 
Hours are midnight to 5:00 am and the Door C Timezone is 12:30 to 5:00 am. 

• Door D: Night Shift can always access Door D because it has a timezone of Always.  

The Maintenance Staff Access Group 
• Door A: Maintenance Staff Access Group can access Door A (except for the first half hour) 

because Door A has a Timezone of 17:30 to 23:00 and Maintenance Staff Access Group has 
a timezone of 18:00 to 23:00 

• Doors B and C:  cannot access B or C  

• Door D: can access D because it has a timezone of Always. 

Note:  The doors have a different timezone for the Access Group Night Shift than they do for 
the Access Group Maintenance Staff. Each Access group has different times when it can 
access the same doors. 
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Default Timezone 
Each Access Group has a default timezone assigned to it. When you create a new door, Door X, 
it will by default be accessible to each Access group during a different timezone. 

How can you create this default timezone? You set the default timezone for each Access Group 
when you create the Access Group.  See the procedure below, How do I create an access 
group?  

In the example below, the selected Access Group is Night Shift, which has the default timezone, 
named Night Owl.  

This means, that if you create a new door and assign the door to the Access Group Night Shift, 
members of that group will automatically be given access to that door during the timezone Night 
Owl. If you assign the door to another group called Office Staff, they will have access to the door 
only during the timezone called Standard – Standard is the default timezone for the Access 
Group called Office Staff. 

You can change these default timezones if you want by opening Access Groups , selecting 
the door and changing the timezone on that door for the selected Access Group. 

In the illustration below, Shipping Door 003 has had its timezone changed from Night Owl to 
Always because you want some deliveries to the customer to be made during the day even 
though most shipping takes place at night. 

 

The list of all the doors is shown at the bottom right.  

• An access "group" may be created for just one User, if this individual needs access at a 
special time. 
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Note:  Doors to which the selected Access Group has access appear in green; other doors 
appear in black. In the example above, the Night Shift Access Group has a default timezone 
of Night Owl, so doors with the Night Owl timezone appear in green. The door Montreal Mar-
002 appears in black because its timezone is Standard, which has different hours from Night 
Owl. 
 If you find it hard to remember the hours for each timezone, just click on the timezone icon 

 and check on the timezones.  

Note:   When viewing Lists of Doors to assign to Access groups, you can use the category 
of User Group as a viewing filter device, so that only the doors assigned to a certain User 
Group are visible.  Often members of a User Group have the same patterns of door access. 

Create Access Groups 

HOW DO I CREATE AN ACCESS GROUP? 
1. Ensure that you have created Doors and timezones.  See Create Doors and Create 

Timezones, Vacations and Holidays.  

2. From the System Administration field on the main menu, select Access Groups or click on the 
Access Groups icon. 

 

 

3. The Access Group Management Group dialog box appears. 
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4. Click on the  button to clear the Group Name field. 

5. In the listbox called Group Name, type the name for the new Access group you want to 
create. The name should refer to the timezone during which the new group will have most 
access. 

6. Click on the dropdown listbox on the right to view the menu of timezones that you created in 
the procedure Create Timezones.  Select the default timezone that you want this access 
group to have when a new door is assigned to it. It's easier to remember if you give the new 
access group a name that reflects its default time zone. For example, call a group "night shift" 
if you are giving it the default timezone called "night owl", because "night owl " hours are 
00:30 (12:30 midnight) to 7:00 for the work week. 

7. Click on the  button at the bottom left. 

8. The new Access Group name appears on the list under Group Name. The default timezone 
you selected also appears on the dropdown at the top right of the right-hand panel. 

9. You must click Save right after you create a new Access Group. If you try to make other 
changes before saving, you will receive a message like the following: 

  

On the list of doors, doors that are never accessible to the Access Group you have selected 
appear circled in red like Montreal Mar-001 and Montreal Eng-Conf in the example below: 
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Note:  If the timezone during which the door is accessible is the same as the timezone 
assigned to the selected access group, the door's name appears in green.  If a door's 
timezone is not the same as the group selected, the door name appears in black. In the 
example below, the selected access group is daytime. Doors accessible during the Standard 
timezone, for example, appear in green.  Montreal Eng-Conf appears in black because its 
timezone, "Always", does not match the Standard timezone assigned to the group called 
Daytime. 
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Assign Users to Access Groups 

HOW DO I ASSIGN USERS TO ACCESS GROUPS? 

1. Select the Users tab . 

2. Select a User from the List of Users. 

   

3. Select the Profile  tab. 

4. From the dropdown menu in the Access Group box, select the desired group. 

   

5. Click on the update button to save the information. 

Note:  To verify that her Access Group has changed, click on the Access tab with Carmina 
still selected as the User, and see that her Access group is now office staff. 

Assign User Group Members to Access Groups  

In the procedure Assign Users to Access Groups, you assigned individual users to an Access 
Group.   It may be easier to see all the users that you plan to assign to a particular Access pattern 
by viewing each User Group.  Members of a User Groups tend to need access to the same doors 
at the same hours.  This procedure will show you how to assign members of a User Group to an 
Access Group. 

HOW DO I ASSIGN USER GROUP MEMBERS TO THE SAME 
ACCESS GROUP?  

1. Select the Users Groups tab .   

2. Select the User tab    

3. The following screen appears: 
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The users who are members of the selected User Group (Sales), are shown in the bottom left-
hand panel. 

Imagine you want all the members of this User Group to be in the same Access group. This is 
often the case because employees with similar activities often need access to the same doors at 
the same hours. 

Select the members of the User group, Sales, by clicking on the first name and holding down the 
Shift key till all the members are selected, as shown below. 

 

4. Click on the Access Group Button at the bottom right of the panel. 

The list of Access Groups appears. 
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Note:  The screen above shows the list of all possible Access Groups.  It does not show the 
users' current Access Group.  It can't show this because if you select five users as in the 
example above, they may all belong to different groups.  What you select on the list is the 
Access Group where you want to place all these users.  Select the Access Group you want 
to assign to that User Group sales hours in the example shown above. 

5. Click OK. 

To verify that all your selected users have changed their Access Group to Sales Hours, check 
some users who are members of the Group in User, Profiles and you should see their access 
group appearing as sales hours.  

Two examples are shown below. 

 

 

  

We can see that Bob Bargan and Dana Diskount are now both in the Access Group called Sales 
Hours. 
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Change a User's Access Group 

Most Users and User groups have a pattern of access to certain doors. However, if a User or 
User group changes its pattern and needs access to another door or set of doors, you must 
change the Access Group.  
Access permission and time data are all stored in the lock, so the lock or locks must be re-
programmed each time you change User or User group assignments. 

HOW DO I CHANGE A USER'S ACCESS GROUP? 

1. Select the  tab. 

2. Select User from List (Dina Davis in the example shown below). 

3. Select the Access tab . 

4. The following panel appears at the lower left of your screen:  

 

The screen shows all the doors available to the selected User, and the timezones in which they 
are accessible to her. She has access to Eng-003 and Eng-002 and Mar-002 because her 
Access Group is Office Staff and the timezone for that Group is Standard. 

You can view the user's current access timezone by double-clicking on the timezone name for a 
given door, Eng-003 for example. 

Double-click on the Standard timezone for Eng-003 and the following box appears. 
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The current timezone is "Access Group TZ", which refers to the default timezone for the selected 
Access Group.  The default timezone for the Access Group "Office Staff" is Standard. 

So, we know that the door Eng-003 is available to the Office Staff Access Group during the 
timezone called Standard. 

5. Click on the Access Group dropdown listbox and select the new Access Group (Night Shift) 
to which you want to assign this user, Dina. 

6. Select Night Shift. 

The doors that were available to her because they had the same timezone as her access group 
(Office staff Access Group uses the “Standard” timezone) are now available to her only at night. 
The timezone for the doors on the list changes to "Night Owl" (Night Shift Access Group uses 
Night Owl Timezone) 

 

For information on how to change the User's access to specific doors, rather than changing her 
access group, which changes all doors in the group, see Change User Access to an Individual 
Door below. 

 



Solitaire 950 User Manual 

98    PK 2828 02/05 

 

Change User Access to an Individual Door 

HOW DO I GIVE ACCESS TO AN INDIVIDUAL USER OUTSIDE OF 
HIS ACCESS GROUP TIMEZONE? 
If a User needs to access a door at a time when he /she normally could not, there is a way to do 
this.  In the example below, we see that the User Carmina has access to four doors during her 
access group's timezone.  Her access group is Night Shift, which has the Night Owl timezone.  
Now she needs access to the door Mar-001 during the day, during Standard working hours.  
Follow the procedure below to change her access to that one door. 

1. Click on the Users tab  on the upper panel of your screen. 

2. Click on Access  on the lower panel. 

3. The list of doors available to the selected User appears, showing the timezone for each door. 

 

3. Double-click on the door  (Mar-001) where you want to change the User's Access timezone. 

The Select Timezone box appears as below. 
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4. Click on Standard to change the timezone for this door from the ACCESS GROUP TZ (in this 
case Night Owl timezone) to Standard timezone. 

 

The timezone for Carmina to access that individual door has changed to Standard. 
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Delete Access Groups 

HOW DO I DELETE AN ACCESS GROUP? 
1. From the System Administration field on the main menu, select Access Groups or click on the 

Access Group icon. 

 

 

2. The Access Group Management Group dialog box appears. 

3. In the listbox under Group Name, select the name of the group you want to delete. 

 

4. Click on the  button at the bottom. 

5. First, you'll be asked if you really want to delete that group 

 

6. Second, if you click Yes, you will be warned if there are still Users in the group. 
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7. If you don’t receive this message, click Yes and the Access Group will be deleted and 
disappear from the list as shown below. 
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Chapter 5: Encoding and Using Keycards 
Special Keycards – General Information 

• Special keycards should be restricted to those who require them, and each person should 
have one keycard with only the access he/she requires.  

• Emergency keycards should be available to selected personnel: facility managers, shift 
guards, fire marshals, etc. Emergency keycards should not circulate. 

• Lost keycards must be reported immediately to ensure security. 

• Keycards for Area, Section Room and Floor must be assigned to specific Users.   

• Programming keycards (Initialization, Programming, Spring and Fall) are not assigned to 
specific Users. They can be used by anyone.   

• Lockout and Reset keycards of all types are also not assigned to a particular User as they 
are used in e-emergency situations and should be under the Master Administrator's or 
Security chief's control. 

For information on creating keycards, see Encode Master and Special Keycards on page 110. 
For information on Lock Response, see Keycard Status Indicators on page 108. 

Keycard - Area, Section, Floor and Room 
Master Keycards 

What is the purpose of creating these four types of keycards?  If you don’t have a regular access 
card, for example, if you are a temporary maintenance person who is called in to clean heating 
and air conditioning ducts all over the facility, you could use one of these KABA Master Keycards. 

Another example would be the Maintenance Manager who would want an Area or Section key to 
check not only all the Rooms but also the closets etc.  They would only need to carry one keycard 
that would open all the doors. The definition for each of these cards is flexible.  For example, an 
Area card could have access to four corridors and 80 doors, or only 1 hall with 2 doors.  There is 
no set definition; it is up to you, the Solitaire 950 application user, to define Area and Section 
according to the structure and size of your facility.  Floor and Room keys define obvious areas. 

• Each of these KABA Master keycards can open all the locks in a pre-defined area, section, 
floor or specified room, regardless of lockout conditions.  

• You can use this card as your User card or carry it with you in addition to another User card. 
It is generally more convenient to carry just one card if it includes the room or rooms to which 
you need access. For example if your office, the Conference Room where you hold meetings 
and the Library where you read are all in one section, you could use an KABA Section card. 

• An Area Master Keycard gives you access to all the doors in an area even if it is in lockout 
mode.  

• Section and Floor Master Cards similarly give access to an entire section or floor regardless 
of lock mode.  

• A Room card gives access to a specified room, for example, a lab in the x-ray wing on the 4th 
floor of a different building from the one where you have your office. 

 
Keycard - Reset for Area, Section, Floor, Room 

Purpose: Cancels the existing Area, Section, Floor or Room keycards in circulation from any lock 
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in the pre-defined area, section, floor or specified room.  

Required: This card is used if one of these Master Keycards is lost. 

Keycard – Initialization 

Purpose: Transfers the unique Internal Identification number of your software to the lock. 

Required: After lock installation, after battery replacement. 

Lock Response: Simultaneous green and red flashes, followed by one green flash after first time 
use only. 

Expiry: None 

Keycard – Programming 

Purpose: Activate the lock for programming or auditing. 

Required: Before programming and auditing. 

Lock Response: One 30-second green flash, during which time communication with the 
Maintenance Unit (MU) must take place. 

For the procedure to create a programming keycard, see Encode Master & Special Keycards on 
page 110. 

Keycard - Battery Test 

Purpose: Determine charge level of the lock battery. 

Required: When charge level of the lock battery is in question. 

Note:  If the battery is low, this will show, as described below in Lock Response, whenever a 
User swipes a card through a lock.  This should alert you to change the battery. 

Lock Response: One green flash indicates sufficient charge level. Simultaneous green and red 
flashes indicate the battery must be changed. 

Expiry: None 

Keycard - Temporary User 

Purpose: Opens all doors to which users have access at the times when they have access.  

Required: The Temporary card can be issued to the user who has lost or misplaced his/her 
permanent user card. That user can use the Temporary card to gain access before the new 
permanent card is made or until he/she finds the permanent card. The default valid time of the 
Temporary card (selected in the Defaults for Expiry Dates and Timers tab of Set Up Workstation 
on page 42 is 2000 days, but the expiry time can be specified when you make the Temporary 
card.  A temporary keycard can also be issued to someone needing access for a defined period 
of time - a consultant, an elevator repairman, etc.   
The administrator uses a Cancel card to disable the access on the temporary card.  Each 
temporary user keycard is part of a pair – the access keycard and the cancel keycard.  
Once the temporary user card is cancelled, the user can go back to using his permanent user 
keycard. The default valid time of the Cancel card is 24 hours, but it can be changed. 
The temporary user keycard has a viewable sequence number on it, whereas the permanent 
keycard uses the ABA format where the sequence number is encrypted. 

Note: If the customer’s permanent card has a sequence number encoded on it, a newly 
made permanent card (encoded by the customer’s system) will automatically cancel the 
previous (or lost) card, after swiping the affected locks at least once. If the card does NOT 
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have a sequence number encoded on it, you will have to reprogram the locks) to cancel the 
old card and to enable the new permanent card. 

Keycard – Permanent User 

Purpose: Open all doors to which users have access at times when they have access.  

Required:  A permanent keycard is for use of a permanent employee, a long-term resident in a 
facility or anyone who needs access for a long time. There is no default expiry date for a 
permanent keycard.  An expiry date can be selected - see Encode Permanent User Keycards.   

See Delete Users on page 56 for ways to delete a permanent user and Encode Cancel Keycards 
or the procedure for encoding a cancel keycard. 

Keycard - Emergency 

Purpose: Open all doors at all times regardless of any timezone restrictions even if the deadbolt 
is projected.  

Required: When immediate access is required and the Access Keycard is not available. 

Lock Response: Flashing green for six seconds under normal circumstances. Access granted. 

Expiry: None 

Keycard - Emergency Reset 

Purpose: Invalidate the current Emergency keycard in the lock. 

Required: When the Emergency keycard is lost or stolen. 

Lock Response:  Single red flash. 

Expiry: None 

Keycard - Facility Lockout  

Purpose: Temporarily lock out all User keycards for the whole facility so that no access is 
permitted. Only the Emergency keycard or a mechanical key can open any doors. 

Required: This could be used in case of a bomb threat, for example, or a gas leak, so that no 
Users can enter the facility until the "all clear" is given. 

The Keycard called Facility Lockout Reset restores all locks in the facility to normal operation. 
There is no need to re-program the locks. 

Solitaire 970 Entrance Lock 
Although the Solitaire 970 Entrance Lock normally overrides Solitaire 950 functions when it enters 
Passage Mode because the inside lever remains depressed, the Lockout keycard will remove 
the lock from passage mode. After the Lockout keycard has been used, depressing the inside 
lever will not return the 970 lock to passage mode. To return to normal Solitaire 970 functionality, 
use the Lockout Reset keycard. 
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Keycard - Facility Lockout Reset 

Purpose: Restores the lock to normal operation after the Keycard - Facility Lockout has been 
used. 

Required: When the area no longer needs to be sealed off. 

The Facility Lockout Reset keycard restores the lock to normal operation after the Facility Lockout 
Keycard was used (no need to reprogram the lock). The non-duplicate Facility Lockout Reset 
Keycard also cancels the existing Facility Lockout Reset keycards. The maximum expiry time for 
Facility Lockout and Facility Lockout Reset keycards is seven years from time of creation. Other 
special keycards do not have an expiry time. 

Solitaire 970 Entrance Lock 

To return to normal Solitaire 970 functionality after the Lockout keycard has been used, use the 
Lockout Reset keycard. 
Lock Response: Single Green 

 

Keycard - Room Lockout  

Purpose: The Room Lockout card enables privacy mode. When the card is swiped through the 
lock, all regular User cards are temporarily disabled. No one can get access to the room. 
However, Users with Master cards or mechanical keys can open the lock.  

Required: This card can be used if you want to seal off a room temporarily because of a problem 
with the room or if you need absolute privacy in the room for a period of time 

Keycard - Room Lockout Reset 

Purpose: Room Lockout is cancelled by using a Room Reset Lockout card. 

Required: To unlock a room previously in Room Lockout mode and return it to normal mode. 

Note: Duplicates may be created for Emergency, Emergency Reset, Lockout, or Lockout 
Reset. The other Special keycards cannot have duplicates made. The creation of another 
card will replace the previous card. 

Keycard - Cancel  

Purpose: A Cancel keycard is used to cancel a temporary keycard’s access to a lock. 

Required: To cancel room access for a particular user. 

Swiping the cancel keycard through all locks to which the user had access removes the user's 
temporary keycard access so if they try to use their keycard in the locks, it will not work.  

Keycard - Room One Shot 

Purpose: This is similar to the Room keycard described in Keycard - Area, Section, Floor, and 
Room except that it will work only once. The card will open only one specified room only once. 

Required: This can be used if someone has to get into a room in an emergency and doesn't 
have a User keycard or room keycard. For example, there's an important file in an office and the 
User is off sick the day that the file needs to be given to the customer. You could get a Room One 
Shot card to just go in and retrieve the file without having to change your User or Room card. 
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Keycard - Spring 

Spring Keycard: Start of Daylight Savings Time 
The Spring Keycard advances the lock time by one hour to coincide with the Daylight Savings 
Time period beginning in the spring. Insert this keycard in all locks on the first day of Daylight 
Savings Time. 

When the change from Standard time to Daylight Savings occurs, you will receive the following 
message on your screen: 

 

For information on creating a Spring keycard, see Encode Master & Special Keycards on page 
110.  Using the correct time is extremely important for lock audits – you want to have accurate 
records of door usage. 

For information on Lock Response, see Keycard Status Indicators on page 108.  

Keycard - Fall 

The Fall Keycard turns the lock time back by one hour to coincide with the Standard Time period 
beginning in the fall. Insert this keycard in all locks on the first day of Standard Time. 
For information on creating a fall keycard, see Encode Master & Special Keycards on page 110. 
Using the correct time is extremely important for lock audits – you want to have accurate records 
of door usage. For information on Lock Response, see Keycard Status Indicators below. 
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Keycard Status Indicators 

 Solitaire 950  

LED INDICATOR FLASH  KEYCARD USED RESPONSE 
Flashing green (for up to 
6 seconds) 

Emergency and User Access granted,  
flashing stops when the handle is turned. 

Battery Test 

Spring 

Fall 

Resident User (same 
Resident 

Single Green 

  

Lockout Reset Lockout 
User keycard is used 
again within 1 minute) 

Battery is OK 
 

Lock time is advanced one hour. 
 
 

Lock time is set back one hour. 
  
 
 

Access restored for valid Users 
 
  
Lock is put into passage mode. 
 
 

  

 Single red User 

 

 

Emergency cancel 

 

 

 Lockout 
 

 

Resident User (same 
Resident User Keycard is 
used again within one 
minute) 

 

Invalid ID, Access denied 
 
 

 
All Emergency keycards created before the 
Cancel keycard 
are disabled. 
 
 
Access denied for any valid User card 

 
 
The lock is set back to the Locked Mode or stays 
in the locked mode. 
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LED INDICATOR FLASH  KEYCARD USED RESPONSE 
No light User 

 
Emergency and User 
 
Emergency  

 
Initialization 

 

All 

Keycard is expired or not valid yet or lock is in 
lockout mode. 
 
Lock time is not set 
 
This card was cancelled by an Emergency 
Cancel keycard 
 
Lock is already initialized 

 
Badly encoded or damaged keycard. 

Single green and red  Battery test  Battery is low. 

Single green and  
red (with red longer) 

All  Lock is not initialized. 

Green and red (with 
 green longer), green 

 Initialization  Lock is initialized. 

Green and red, green, 
red 

 Initialization Lock is initialized and the thumbturn is in the 
locked position. 

Green and red 
simultaneously, green, 
flashing green 

Test Lock is installed but not programmed.  Used 
during construction and installation. 

Long Green (30 sec) Programming Communication with Lock is enabled 

Green, red, green  User Valid ID but invalid time zone; access denied. 

Green, red, red  Non-Resident User Valid ID but Resident lockout is enabled 
or deadbolt is thrown; access denied. 

Green flash (6 sec.), red  Resident User Resident lockout is enabled. 

Red, green flashing (for 
up to 6 sec.) 

 Resident User Access granted for the Resident User; Resident 
lockout removed if handle is turned. 
Access granted for the Resident User; deadbolt 
lockout is not removed. 

Red, green flash (6 sec.), 
red 

Resident User Resident lockout is re-enabled on a Resident 
if the handle is not turned during the 6 second 
flashing phase. 

 Flashing green 
 and red  
(for up to 6 seconds) 

 User Battery is low. 
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Solitaire 970 Entrance Lock 

LED INDICATOR 
FLASH 

 KEYCARD USED  MEANING 

Flashing green (for up 
to 6 seconds) 

Emergency and User Access granted for 6 seconds  
Passage mode is removed if it 
exists; lock is set to lock mode 

Single Green 

  

Test 

Battery Test 
Spring 
Fall 
Lockout Reset 

Lock is operational 

Battery is OK. 
Lock time is advanced one hour. 
Lock time is set back one hour. 
Access restored for valid Users 

User  Invalid ID or deadbolt projected; 
access denied. 

 Emergency Reset 

 

Lockout 

All Emergency keycards created 
before the Reset card are 
disabled. 
Access denied for any valid User 
keycard. 

No light User 

 
Emergency and User 

 
Emergency 

 
Initialization  

 
All 

Keycard is expired or not valid yet 
or lock is in lockout mode. 

Lock time is not set 
 
This card was cancelled by an 
Emergency Cancel keycard 
 
Lock already initialized. 
 
Badly encoded or damaged 
keycard 

Single green and red  Battery test  Battery is low. 

LED INDICATOR   KEYCARD USED  MEANING 
Single green and  
red (with red longer) 

All  Lock is not initialized. 

Green and red (with 
 green longer), green 

 Initialization  Lock is initialized. 

Green and red, green, 
red 

 Initialization Lock is initialized and the 
thumbturn is in the 
locked position. 

Flashing green 
 and red  
(for up to 6 seconds) 

 User Battery is low, access granted 
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Encode Permanent User Keycards  

HOW DO I ENCODE A PERMANENT USER KEYCARD? 
You must use a High-C encoder for this procedure. 

1. From the Main Panel select Users tab.  

 

2. Click on the user who needs a new permanent ABA keycard.   

3. In the Lower panel, click on the Keys tab.  Two panels appear: Keycard Generation/Expiry 
Date and Time and Keycard History. 

 

If you click on Expiry Date  but then click on the Encode Permanent Keycard button, you will 
see the radio button jump to “No expiry set for this keycard.” because you cannot set an 
expiry date for a permanent keycard.  

 

 

4. Choose Encode the keycard for the current user, the bottom of the two buttons on the right. 

5. Wait for the Ready light on the encoder to light up. and the prompt from the High-C Motorized 
encoder.  (Remember, this is the only encoder you can use to make permanent keycards). 
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In case you selected an expiry date by mistake, the keycard popup will look like the 
following. 

 

 

6.  Swipe the user's keycard through the encoder. 

7. The encoder encodes the card and sends the following message: 

 

8. The new permanent user keycard appears on the keycard history list. 

9. To verify the information on a user keycard, select the card you want and click on the 

Read/Verify button on the right.  

10. Information about the card you have just encoded should appear.  
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if there is a problem with the card, the following message appears: 

 

11. The problem could simply be that you did not swipe the card properly. Always try a second 
time. 

12. To verify the information on a temporary user keycard, select the user you want and click on 
the top button. 

13. Insert the user card you just created, and the history of that card, including creation date, will 
be highlighted in the keycard history list. 

You have successfully created a permanent user keycard. 

Note: There is no procedure to delete a User Keycard. Once you have deleted a user, his/her 
keycard is invalid in all locks. See the procedure Delete Users.  

 

Encode Temporary User Keycards 

HOW DO I MAKE A TEMPORARY USER KEYCARD? 

1. From the Main Panel select Users tab.  

2. Click on the User who needs a temporary keycard. 

 

3. In the Lower panel, click on the Keys tab,  Keycard Generation appears. 
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4. Click on Expiry Date for the card if you choose to set an expiry date.  The default expiry is 
2000 days. 

5. A calendar appears. Select the expiry date you want to assign to that keycard. 

 

If you do not choose a date from the calendar, the expiry date, which you set in Default Expiry 
and Timers, will be used. 

6. Choose Encode the temporary keycard  for the current User. 

7. Wait for the Ready light on the encoder to light up and wait for the following confirmation 
request from the encoder. 

 

8. Swipe/insert the User's temporary keycard through the encoder. 

9. The encoder encodes the card and sends the following message: 
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10. The new temporary User keycard appears on the keycard history list. 

11. To verify the information on a temporary User keycard, select the card you want and click on 
the Read a Card button on the right. 

 

12. Information about the card you have just encoded should appear: 

 

13. If there is a problem with the card, the following message appears: 

 

14. The problem could simply be that you did not swipe/insert the card properly. Always try a 
second time. 

You have successfully created a User keycard. 

HOW DO I ENCODE A CANCEL KEYCARD?  
For definition of this keycard, see Keycard – Cancel on page 106. 

1. From the Main Panel select Users tab.  

2. Click on the user whose access you want to cancel. 

 

3. In the Lower panel, click on the Keys tab.   Two panels appear: Keycard Generation and 
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Keycard History. 

 

 

4. Click on Expiry Date for the Cancel card if you choose to set an expiry date. A calendar will 
appear. Select the expiry date you want to assign to that keycard. The default for a cancel 
keycard is usually 24 hours – enough time to swipe it through all the locks 

 

5. Click on the Cancel keycard  button.  

6. Wait for the Ready light on the encoder to light up and the confirmation request from the 
encoder appears. 

.  

7.  Swipe/insert the keycard through the encoder. 

The encoder encodes the card and sends the following message: 
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8. To verify the information on a user keycard, select the card you want and click on the Verify 

keycard button . 

9. Information about the card you have just encoded appears: 

 

If there is a problem with the card, the following message appears: 

 

The problem could simply be that you did not swipe/insert the card properly. Always try a second 
time. 

10. Swipe the Cancel keycard through all the locks where that user had access as soon a 
possible, to avoid any illegal access. 

You have successfully created a Cancel keycard. 

Encode Master and Special Keycards 

HOW DO I ENCODE A SPECIAL KEYCARD? 
The swipe keycard encoder will be used only to make temporary user keycards or Special Master 
keycards. With the new motorized encoder you can encode ABA permanent keycards. First, read 
the definitions in Special Keycards to make sure you understand the functions of each Keycard. 

1. From the Main Menu, select System Administration. 

2. Select Master and Special Keycards. 

 

3. In the Keycards dialog box, select the keycard you want from the dropdown menu. In the 
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example below, the Initialization keycard has been selected. 

 

Note: Additional fields appear if more information is required, for example, User and Room, 
floor or area ID: 

 

4. An explanation of the card's function appears in the window below the dropdown menu. The 
Keycard history, if any, appears in the bottom panel. 

Note: The Reader/Encoder should be activated once you plug in your encoder or choose 
pre-set encoder. The button should appear activated as below - it should not be grayed out. 
If it is grayed out you should re-boot your computer with the encoder connected to the COM 
port cable. 

 

5. Choose Create a new keycard or Make duplicate by clicking one of the choices and then click 
the Encode Keycard button at the right. 
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6. Wait for the Ready light on the encoder to light up.  

The confirmation request from the encoder appears. 

 

7.  Swipe/insert the new keycard through your encoder. 

8. The encoder encodes the card and sends the following message: 

 

9.  The new special keycard appears on the keycard history list. 

10. To verify the information on a special keycard, select the card you want and click on the Read 

a Card  button on the right. 

11. The information on the card you have just encoded should appear: 

 

12. If there is a problem with the card, the following message appears: 

 

The problem could simply be that you did not swipe/insert the card properly. Always try a second 
time. 
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HOW DO I ENCODE AREA, SECTION, FLOOR OR ROOM 
CARDS? 

     

1. First, select Area, Section, Floor or Room 

2. Select the number 

 

3. Follow Steps 5 to 9 of the procedure to Encode Master and Special Keycards.  
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Lock Status Indicators 

The LEDs on the electronic lock flash in a certain sequence, depending on the keycard used or 
the situation. The charts give the LED flash patterns and their meanings. LED response to 
situations 

 LED INDICATOR FLASH  MEANING 

After battery connection 

No light 
 

  

The thumbturn is in the passage mode position. 

Single red within 4 seconds  
The thumbturn is in the locked position. 

Still red Battery is low. 
  

Thumbturn is turned 
 (for Passage Mode) 

Single green The lock is put into passage mode. 

Single red 

  

The lock is set back to the locked mode. 

The lock stays in the locked mode in the following 
cases: 

• If Passage mode is disabled 

• If Deadbolt is projected 

Thumbturn is turned (for deadbolt) 

Single green Deadbolt lockout is removed. 

Single red Deadbolt lockout is set (passage mode is removed if 
it exists). 

Handle is turned (while in passage mode)   

Single green and still red Battery is low 

Lock failure 

 Single red every second The lock has failed 

 Key to LED descriptions: 

Green and red = Simultaneous -The green and red LEDs flash together once, 
Green, red = Sequential - The green LED flashes, then the red LED flashes 
Still red (or green)= LED remains the same color and does not flash 
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Solitaire 970 Entrance Lock LEDs 

 

LED INDICATOR FLASH MEANING 

Solid Red Battery is low 

Inside lever is depressed (for Passage Mode) 

Single Green  1) Lock is put into Passage Mode. 

2) Deadbolt Lockout is removed. 

Thumbturn is turned (for Deadbolt) 

Single Red 1) Deadbolt is projected 

2) Passage Mode is removed if it is activated 

3) Lock is set to Locked Mode 

Lock Failure 
Solid Red constantly Lock has failed 
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Chapter 6: Using the Maintenance Unit 
General information 

The Maintenance Unit (M-Unit) is the software application in the Solitaire 950 that enables you to 
exchange information with the locks - either uploading new data to the lock or downloading audits 
from it. 

When to use the M-Unit to program locks  

Locks need to be programmed if they are new or if you have changed or added new User access, 
doors or timezones, for example.  

• Doors (locks) appearing on the list of doors with a red traffic light require programming.    

• Green traffic lights signify the lock is up to date. 

In the illustration below,  

• Montreal Main has a green light, so you know the data for it is up-to-date in the MU. 

Note:  Remember that the green light only indicates that you have transferred the 
information about the lock to the M-Unit.  It does not mean that the lock itself is up-to-date. 

• Montreal Engineering 3 is showing a red light, so you need to create a new file for it and 
transfer the file to the M-Unit.  Then, the information must be transferred from the M-Unit to 
the lock.   

 

 

Warning:  It’s important never to leave a lock in Resident Lockout mode before 
programming it.  If the lock is left in that mode and you then re-program it, it will accept 
the new data but the Resident lockout will be unchanged.  The new Users will not be able 
to enter.  Ensure that all locks to be programmed are taken out of Resident Lockout Mode.   

Warning:  Remember to always disconnect the programming module from your M-Unit 
(especially a laptop) when you are not using it. Each programming module contains a 
battery-operated booster. Leaving the cable connected to your computer will drain the 
booster battery. 
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Two Programming Methods -Integrated (Direct) or Separate (Indirect) 

§ The M-Unit application may be used in two ways: 

§ Data is programmed directly into the locks from a laptop PC containing the Solitaire 950 
Windows database and the M-Unit software. 

§ Data is programmed into the locks from a diskette in a laptop PC containing only the M-
Unit application. 

§ To program a lock using either method, the Programming Module is connected to the 
COM port of the PC and then inserted into the lock. 

Integrated (Direct) Method 
The PC/M-Unit transfer of information from a PC containing both applications (Solitaire 950 and 
M-Unit) is known as the Integrated (Direct) method of programming the locks.  

Starting up 
When the Integrated (Direct) method is used, choose Start> Programs>Solitaire 950 from the 
Windows Startup menu. There are three program icons. Select the Solitaire 950 icon to open the 
application. 

 

 

Separate (Indirect) Method 
Programming the locks from a laptop PC loaded with only the M-Unit application is known as the 
Separate (Indirect) method. In the Separate (Indirect) method, the data to be transferred to the 
locks is copied from the main PC (loaded with the Solitaire 950 application) onto diskettes. The 
diskettes are then inserted into the laptop PC loaded with the M-Unit application. The portable PC 
is carried around to the locks and data is programmed into the locks via the Programming 
Module. 

Starting up Separate (Indirect) Method 
In the Separate (Indirect) method, the M-Unit application is installed on a laptop PC and it is 

opened by clicking on the M-Unit icon  or by choosing the Programs>Solitaire 950 from 
the Windows Startup menu. 
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M-Unit Application Interface 
The M-Unit main window has a menu bar and a set of action buttons just like the Main Window of 
the Solitaire 950 application. The M-Unit has its own online help, accessible from the Help button 
in the Menu bar. 
The main window of the M-Unit is pictured below. 
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Setting up the M-Unit - Integrated Method 

HOW DO I SET UP THE M-UNIT? 
1. Open the Solitaire 950 application by selecting Start>Programs>Solitaire 950 and clicking on 

the Solitaire 950 icon. 

 

 

The main window appears. 

 

2. From the Solitaire 950 main menu, select Options>Settings>Workstation. 

3. The Configuration Window dialog box appears. 
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4. Click on the General tab. 

5. Select Integrated (Direct) Method in the dialog box (in the M-Unit Update Method panel) as 
shown above. 

6. Click OK. 

7. Open the M-Unit application by clicking on the Start M-Unit button on the Main Toolbar of 
Solitaire 950, or select Start M-Unit from the dropdown menu under Lock Management. 

 

 

 The M-Unit main window appears. 
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8. From the menu of the M-Unit main window shown above, select Options, then Configuration. 

 

9. In the Configuration Window dialog box shown below, choose the method you will use to 
transfer data to the M-Unit - Integrated (Direct) Update. These choices are shown in the lower 
right hand panel (PC/MU Transfer) of the M-Unit dialog box. Select the COM port, which you 
will be using to program the lock with the programming module. 

10. The PC/MU transfer of information method must also be selected here. Whether you choose 
Direct Update or Diskette is extremely important. The other choices you make will depend on 
which method you selected. The method you select must also be the same as the one you 
selected in the Lock Update section of the Configuration window dialog box. See the 
procedure called Set Up Workstation on page 30. 

The setting called Auto-Program is used when you want to program a door but have forgotten the 
door's ID. Choosing auto-program will cause the lock to detect its own ID and identify itself during 
the programming process. 

11. Select Auto-Program enable/disable. 
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Auto-Program  
A lock may be on your list of doors to program but sometimes when you arrive at the door itself 
you cannot remember the exact name of the door in the software. The door name may be 
different from the name on the physical door. 

If you have selected Auto-program, you don’t have to select a door by highlighting it on the list. 
Just leave the first door highlighted as in the M-Unit main window shown above, insert the 
programming module and click on Program a Lock. (See page 6.)  

When the programming is complete, the highlight on the list will jump to the door you have just 
programmed. In a way, it is safer to always select auto-programming because then there is no 
risk of selecting the wrong door name. 

If you select the wrong name and then program the door, you will change the door’s identity to the 
one selected on the list of doors. If you make this mistake, however, you will see a warning 
confirmation request asking if you really want to continue. 

 

Just click no to cancel and select the correct door on the list. 

Note: You cannot use the Auto-Programming feature when you want to change a door's ID 
or if the lock is newly installed. To program the lock, go to the procedure Program a Lock - 
Integrated Method. 
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Program a Lock Using the Integrated Method 

1. Open the Solitaire 950 application by selecting Start>Programs>Solitaire 950 and clicking on 
the Solitaire 950 icon.  

 

2. The main window appears. 

 

3. Click on Lock Management in the main Solitaire 950 menu, then select 

4. Upload Data to M-Unit or click on the icon for Upload to M-Unit. 
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The dialog box for Upload data to M-Unit appears as shown below. 

 
 

5. Do one of the following: 

• Click on the “Include All Doors” button if you want to update all the doors in the Facility, even 

those doors that appear with a green light beside them , (see page 123) meaning they 
have already been transferred to the M-Unit. 

• Click on the “Include modified doors only” button to update only the doors that have been 

modified, those appearing with a red light on the list of doors. 

• Click Select All or Deselect All to select all the doors on whichever list you are using.  Of 
course you can select/deselect individual doors by clicking on the checkbox opposite the 
name of the door but this “All” option saves time when you have a long list. 

Note:  File Information - The process of programming a lock involves creating a "file" each 
time you download information. The "file" holds the data to program the lock. File size can 
range from small (data for programming only one lock) to very large (new data for all the 
locks in your system.) A box at the bottom left of the dialog box shows you the quantity of 
doors you have selected and the file information on the previous file created - name, date, 
time and size. 

6. If you are not sure if all the locks listed in the previous file were updated, click on the Start M-
Unit icon in the Solitaire 950 main menu. This brings up the M-Unit main window, which 
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shows you the list of doors and their status. 

 

7. Click Create New M-Unit File. The following warning appears: 

 

8. Click Yes. 

9. Click Link to M-Unit. 

The M-Unit dialog box will appear on screen, showing the message "Waiting for command". 

Your MU screen will appear like the illustration below: 
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10. Swipe the Programming Special Keycard through the lock and ensure that the light in the lock 
turns green. 

11. Insert the programming module into the lock as follows: 

• Grasp the module between your thumb and forefinger, using your finger to hold in the 
rectangular spring-loaded button on the right-hand side of the module. 

• Push the prongs into the lock's swipe slot so that the top prong goes in just above the flat 
part of the lock, where the surface curves back toward the door. 

• DO NOT FORCE THE MODULE INTO THE LOCK. Remove it and keep trying until you 
feel the prongs slide into place. 

12. After the prongs are in, release the rectangular button on the right of the module and the 
module will remain in the lock. The left-hand side of the module should just cover the light 
panel. 

13. Click on the Program Lock button on the top left of the dialog box above. You have 30 
seconds to complete Steps 10. and 11. Remember that 30 seconds is quite long, so do not 
hurry span. If you do not complete the action in 30 seconds, you will just receive a message 
that there was a problem communicating with the lock. Just keep trying. 

If you mistakenly select another door on the list when you are actually trying to program Mar-002, 
the selection will jump higher on the list (to Mar-002) and that lock will be programmed. 

14. A message appears telling you that the programming was successful, or informing you of any 
problems if it was not successful. 

15. For a selected lock that did need programming, you will see the following message after you 
have programmed it: 

 

Auto-program Locks 

Auto-Program  
§ A lock may be on your list of doors to program but sometimes when you arrive at the door 

itself you cannot remember the exact name of the door in the software. The door name may 
be different from the name on the physical door. 

§ If you have selected Auto-program, you don’t have to select a door by highlighting it on the 
list. Just leave the first door highlighted as in the M-Unit main window shown above, insert 
the programming module and click on Program a Lock. (See page 6.)  

§ When the programming is complete, the highlight on the list will jump to the door you have 
just programmed. In a way, it is safer to always select auto-programming because then there 
is no risk of selecting the wrong door name.  

§ If you select the wrong name and then program the door, you will change the door’s identity 
to the one selected on the list of doors. If you make this mistake, however, you will see a 
warning confirmation request asking if you really want to continue. 

§ A lock may be on your list of doors to program but sometimes when you arrive at the door 
itself you cannot remember the exact name of the door in the software. The door name may 
be different from the name on the physical door.  
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1. If you have selected Auto-program, you don’t have to select a door by highlighting it on 
the list. Just leave the first door highlighted.  

Click on the MU button  in the main menu button bar.   The M-Unit dialog box 
appears as shown below. 

 

3. From the Options menu, select Options>Configuration. 

 

4. The following Dialog Box appears: 

 



Solitaire 950 User Manual 

PK 2828 02/05   135    

Select the Auto-Program checkbox. Select this option if you want the PC to automatically identify 
the lock. 

5. Click on OK. 

6. The main window appears, now with an Auto Program button instead of Program Lock. 

 

7. If you accidentally select a door not on your list of doors to be programmed and then Auto-
program it (following steps 3 to 17 in Program a Lock – Integrated Method), the door will not 
be programmed.  

8. For example, if your "select doors to be linked to MU" file looked like this: 

 

and you try to auto-program the lock Mar-002 (not selected), you will receive the following 
message: 

 

9. If you select the wrong door on the list but the door that you are programming is also on the 



Solitaire 950 User Manual 

136    PK 2828 02/05 

list, the auto-program feature will automatically select the door where you are.  For example, 
if your "select doors to be linked to MU" file looked like this: 

 

Your MU screen will appear like this. 

 

If you select Eng 0004 when you are trying to program Main-0021, the selection will jump to Main-
0021 and the lock will be programmed. 

Follow steps 3 to 17 in Program a Lock - Integrated Method. For a selected lock that did need 
programming, you will see a message that the programming was completed. 
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Setting Up the M-Unit - Separate Method 

HOW DO I INSTALL THE M-UNIT SOFTWARE ON THE 
PORTABLE PC? 

1. Insert the Solitaire 950 Installation CD into the laptop PC that you will take around to the 
locks. 

2. At the point in the installation when you are asked if you want to install the complete 
application or the M-Unit application, highlight M-Unit. 

3. When the program is successfully loaded the M-Unit icon will appear on your desktop as 
below. 

 

Clicking on this icon will open the M-Unit application.  

HOW DO I SET UP THE M-UNIT FOR THE SEPARATE (INDIRECT) 
METHOD? 
1. Open the Solitaire 950 application on your main PC (not on the laptop where you just 

installed the M-Unit) by selecting Start>Programs>Solitaire 950 and clicking on the Solitaire 
950 icon 

 

The main window appears. 
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2. Select Options>Settings>Workstation. 

3. The dialog box called Configuration Windows appears. 

4. Select the Diskette Method in the dialog box (in the M-Unit Update Method panel) as shown 
below. 

 

5. Click OK to save this setting. 

HOW DO I TRANSFER THE DATA ONTO THE DISKETTE? 
When you transfer your data onto diskettes, be sure that the diskette is new or completely empty. 
If there is already data on the disk, it will be overwritten. 

1. Open the Solitaire 950 application 

2. Click on Lock Management in the main Solitaire for 950 Windows menu, then select Start 
M-Unit or click on the icon for Start M-Unit. 

 

 

The main window for the M-Unit appears. 
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Select Options>Configuration from the M-Unit menu bar. 

 

The Configuration dialog box for the M-Unit appears. 

 

3. In the PC/MU Transfer panel, select M-Unit Update Method, Load from Diskette. 

4. Select your Diskette drive (usually A:) 

5. Click OK. 

 
Auto-Program  
§ A lock may be on your list of doors to program but sometimes when you arrive at the door 

itself you cannot remember the exact name of the door in the software. The door name 
may be different from the name on the physical door. 

§ If you have selected Auto-program, you don’t have to select a door by highlighting it on 
the list. Just leave the first door highlighted as in the M-Unit main window shown above, 
insert the programming module and click on Program a Lock. (See page 6.)  

§ When the programming is complete, the highlight on the list will jump to the door you 
have just programmed. In a way, it is safer to always select auto-programming because 
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then there is no risk of selecting the wrong door name. 

§ If you select the wrong name and then program the door, you will change the door’s 
identity to the one selected on the list of doors. If you make this mistake, however, you 
will see a warning confirmation request asking if you really want to continue. Just click No 
to cancel and select the correct door on the list.  

§ You cannot use the Auto-Program feature when you want to change a door's ID or if the 
lock is newly installed. 

6. Select Auto-Program enable/disable. 

7. Click OK to close the M-Unit Configuration Window. 

8. Close the M-Unit main window. 

9. From the main window of Solitaire 950, select Upload data to M-Unit from the Lock 
Management dropdown menu 

 

or click on the Upload Data to M-Unit icon.  

 
A list of the doors needing to be updated appears as shown below. Notice that the buttons on the 
right now include the options Copy New File to Diskette and Copy Previous File to Diskette, 
because you selected Copy to Diskette as your transfer method in Set Up M-Unit. 

 

Do one of the following: 
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• Leave the selected doors on the list if they are the ones you want to program. 

• De-select the doors you don't want to program. 

• Click on the Include All Doors button if you want to update all the doors in the Facility. 

If you are not sure if all the locks listed in the previous file were updated, look at the list of doors 
in the M-Unit main window and check the Status column. 

Note:  File Information  - The process of programming a lock involves creating a "file" each 
time you program information into the lock. The "file" holds the data you are programming. 
The size of the file can range from small (data for programming only one lock) to very large 
(new data for all the locks in your system.) A box at the bottom left of the dialog box shows 
you the quantity of doors you have selected and the file information on the previous file 
created - name, date, time and size. 

10. Click Create New M-Unit File. 

11. Click on Copy New File to Diskette. You will see a message that the file is being transferred.  
The data is now on the diskette. 

You will see a message informing you that the data has been transferred successfully. To 
program the lock with the data on the diskette, see the procedure called Program a Lock - 
Separate Method below.  

 

 

Program a lock - Separate method 

HOW DO I PROGRAM THE LOCKS WITH THE SEPARATE 
(INDIRECT) METHOD? 
1. Insert the diskette with the data files into your portable laptop where you have installed the M-

Unit program. 

2. Go to Start>Programs>Solitaire 950 and click on the M-Unit icon. 

 

3. The M-Unit main Window appears showing the list of doors to be updated (the data that you 
copied onto the diskette.) 
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4. This procedure is repeating the steps you have already done in the Solitaire 950 application. 
However, you must select these settings again in the M-Unit because it is loaded on to a 
separate PC. 

5. Open the M-Unit application by clicking on the Start M-Unit button on the Main Toolbar of 
Solitaire 950, or select Start M-Unit from the dropdown menu under Lock Management. 

 

 

6. The M-Unit main Window appears. 
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7. From the menu of the M-Unit main window shown above, select Options, then Configuration. 

 

8. Select the method "Load from Diskette" in the PC/MU Transfer dropdown listbox. 

9. Select the diskette drive, usually A: 

 

10. Close the configuration dialog box by clicking OK. The dialog box closes and the M-unit main 
window remains on screen. 

11. Insert a diskette into the chosen drive (probably A:\). 

12. Go to the dropdown menu under Communications (Com) and select Transfer to M-Unit or 

click on the upload icon . 

 

OR 

13. Click on the PC/MU transfer button of the M-Unit 

 

14. Allow some time for the data transfer to take place. 

Next, you see a message (shown below) informing you that the data was transferred 
successfully, 
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15. Then you see the main window with the new information from the diskette now on the list. 

16. Go to the locks to be programmed. 

20. If this is your first time programming locks after an installation or after batteries have been 
disconnected, for example, you’ll need to swipe your Initialization card (see page 1) through 
the lock. 

21. Next, swipe the Programming Keycard through the lock and ensure that the light in the lock 
turns solid green. 

22.  Insert the programming module into the lock as follows: 

• Grasp the module between your thumb and forefinger, using your finger to hold in the 
rectangular spring-loaded button on the right-hand side of the module. 

• Push the prongs into the lock's swipe slot so that the top prong goes in just above the flat 
part of the lock, where the surface curves back toward the door. 

• DO NOT FORCE THE MODULE INTO THE LOCK. Remove it and keep trying until you 
feel the prongs slide into place. 

• After the prongs are in, release the rectangular spring-loaded button on the right of the 
module and the module will remain in the lock. The left-hand side of the module should 
just cover the light panel. 

23. Select the lock you want to program from the list or just continue to the next step if Auto-
program is enabled. 

24. Click on the Program Lock button on the top left of the dialog box above. You have 30 
seconds to complete Steps 17 to 20. Remember that 30 seconds is quite long, so do not 
hurry. 

25. If you do not complete the action in 30 seconds, you will just receive a message that there 
was a problem communicating with the lock. In this case, re-swipe your programming card 
and repeat steps 17 to 20. 

26. A message appears telling you that the programming was successful, or informing you of any 
problems if it was not successful.  

Lock Audits, Reports 

The M-Unit, whether it is integrated or on a separate laptop PC, stores only one audit at a time. 
Each time you do an audit, the previous one gets overwritten. To save audit information for 
Reports, you must upload each audit to the PC before doing another one. There is no limit to the 
number of audits that can be stored in your PC; it is limited only by the amount of space on your 
hard disk. 

Solitaire 970 Entrance Lock 
The report will indicate whether a keycard was used to unlock the door or the interior lever was used to 
unlock the door and set the lock to passage mode. 

HOW DO I AUDIT A LOCK? 
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1. Take your portable PC with the M-Unit software, whether you are using the Integrated 
(Direct) or Separate (Indirect) method, and go to the locks) you want to audit. 

2. Click on the icon for Start M-Unit. 

   

3. The M-Unit main window appears. 

 

4. Connect the programming module to COM port 1 or 2 (whichever you have selected) of your 
PC with the MU application. 

5. Swipe your programming card through the lock. 

6. Insert the programming module into the lock. 

7. From the main menu of the MU, select Communication>Audit Lock 
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Or click on the Audit Lock button. 

8. You'll receive a message when the audit is complete. 

9. The information appears as in the example below. 

 

 

 

 

 

 

10. The audit screen appears automatically when you have just performed the audit. If you want 
to see it later, click on the View Lock Audit button and you see the last audit performed. The 
Download Time shown above refers to the last time data was transferred from the lock to the 
M-Unit. 

11. To generate a report from a lock audit when you have used the Integrated (Direct) Method 
you must go to the Solitaire 950 main application and click on the Download from M-Unit 
button. 

 

12. To generate a report from an audit when you have used the Separate (Indirect) Method, you 
must transfer the data from the diskette using the M-Unit to PC transfer in the 
Communications menu of the M-Unit main menu. 

Type of card used and 
event that took place 

Numeric User ID 
User Name 

No. of  times 
access 
denied 

Card  sequence 
number Time event 

occurred 

Event 
sequence 
number 
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13. Select M-Unit to PC transfer 

14. You will be warned that the previous file will be overwritten 

15. The data will be transferred to the diskette and you will receive a message that the transfer 
was successful. 

 

HOW DO I DOWNLOAD A LOCK CONFIGURATION FIRMWARE 
VERSION? 
Sometimes you want to download information from the lock to the PC. This may be useful if you 
have lost or forgotten data for a particular door or just to have an idea of the door’s usage 
patterns. 

1. Swipe your programming card through the lock 

2. Insert the programming module 

3. Go to the main window of the M-Unit (via the Solitaire 950 Windows application or just the M-
Unit application) and click on the Download Lock Configuration icon. 

 
 OR 

4. Choose Download Lock Configuration (or Lock Time or Firmware Version) from the 
Communication heading on the main menu. 
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In a few seconds, you'll receive a message that the download is complete. To view the 
information, click on View Lock Download and you will receive a report like the following. 

 

IMPORTANT 
When you download a lock configuration to an M-Unit, which stores the information on a diskette, 
space is limited. To save space, only the User ID is shown. The rest of the information is marked 
N/A. Just by knowing the User ID, however, you can get the other information such as last name, 
first name etc. by checking the list of Users. 

You have successfully audited a lock and downloaded the lock's configuration to the M-Unit. Now 
you can use the M-Unit to PC transfer procedure to download the same information to your main 
Solitaire 950 application. 

HOW DO I DOWNLOAD LOCK TIME? 
Downloading lock time allows you to ensure that the M-Unit time is always in sync with the lock 
time. Follow the same procedure as the ones above but click on Download Lock Time in the 
Communications menu. You will receive the following information: 

Click on OK to download the current version to the lock. 

 

HOW DO I DOWNLOAD LOCK FIRMWARE VERSION? 
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The ability to download the lock's firmware version is also important when planning to expand or 
upgrade your system. Select Download Lock Firmware Version from the Communication 
dropdown menu on the main menu bar. You will see the following. 

 

  Lock - Resetting Date and Time  

HOW DO I RESET THE LOCK DATE AND TIME? 
In the main window of the Solitaire 950 application, click on the icon for Start Maintenance 
Unit OR click on the M-Unit icon on the desktop of your separate portable PC containing the 

M-Unit software. Click on the button for Start Maintenance Unit. . The M-Unit dialog 
box appears. 

 

1. If the battery was removed and replaced, swipe the Initialization keycard in the lock. 

2. Connect the programming module to COM port 1 or 2 (whichever you have selected) of your 
portable PC with the M-Unit application, (laptop). 

3. Swipe the programming keycard through the lock and wait until the green light appears. 

4. Insert the programming module into the lock. 

5. Click on the Reset Lock Time button (at lower right) on the MU. 

You will see the following message: 
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The lock date and time has now been reset. 
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Chapter 7: Database Utilities 
Database - Backup 

Solitaire 950 comes includes a special database utility program that imports/exports files, and 
also restores and repairs your database.  To perform these database operations, you must open 
the separate file DB Utility installed when the Solitaire 950 was installed. Database operations 
cannot be conducted from the DB Utility program when the main application is running. 

 
MAKE SURE YOU HAVE A BACKUP OF YOUR CURRENT DATABASE before performing any 
repair procedures. To back up your current database, follow the procedure below. There is no 
need to go to the DB Utility Application.   

Databases must be backed up on your computer or on your local network, not on diskettes. 

 
Registration (RF) File: The “RF” file is proprietary to KABA Ilco.  It contains your unique 
password for your database.  You do not need to deal with this file at all but if it gets lost, you will 
not be able to access your database and will need to make a service call to KABA technical 
support to break into the database and set up a new password.  Therefore, it’s a good idea to 
back up your RF file each time you back up a database and store it in the same location so you 
will not lose it. 

HOW DO I BACK UP MY CURRENT DATABASE? 
From the main menu, select Options>Settings>Workstation and click on the Database 
Backup tab at the far right of the dialog box. You must click on the arrow pointing right in 

order to see this tab because it is to the right of the Users and Doors tab.  

1.  The following dialog box appears (with the first two fields blank): 
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:  

2. Browse in each listbox by clicking on . 

3. Enter a name for the database you want to back up.  

4. Accept the file location shown or browse to another location for the backup file. 

5. Select a name and location for the RF file. It can be in a different location as long as you 
remember where you put it. 

6. The dialog box above shows names and locations filled in: 

7. From the File dropdown menu on the main menu, select Backup Database. 

 

8. Click on Backup Database and wait a few seconds or longer depending on the size of your 
database. 

9. Verify that the database was backed up by looking for the file in the location you selected 
(C:\2.0.2.0in the example).  If the database is there, your backup was successful. 
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Database Cleanup 

Database Cleanup is a function that allows you to deliberately purge your audit records instead of 
waiting for the system to do it at pre-set times.  In the section called Create default Expiries and 
Timers in Setup Workstation on page 42, you can set the System to automatically purge 
System Activity Logs and/or Audit Logs after an amount of time you choose, up to a maximum of 
365 days.   

If you do not want to wait for the automatic deletion of the records, use this Database Cleanup 
function to purge records manually. 

HOW DO I CLEAN UP MY CURRENT DATABASE? 
1. Go to the main menu of the Solitaire 950 application (not the DB Utilities application). 

2. Click on Options and select Database Cleanup from the dropdown menu. 

 

The following dialog box appears: 

 

3. Go to the dropdown menu in each category you want to purge and select number of days you 
want to apply – 360 days being the maximum.  Of course, you can choose a different number 
of days for each category. 

4. The cleanup button is now activated and you can click on it to purge the records. 
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Import ASCII files 

HOW DO I USE THE UTILITY TO IMPORT ASCII FILES? 
To perform import/export database operations, you must open the separate file DB Utility 
application, installed when the Solitaire 950 was installed.  

Note: The database operations are for standalone Solitaire 950 software configurations. If 
your Solitaire 950 runs in a NETWORK configuration, DO NOT PERFORM THESE 
DATABASE OPERATIONS. See your database administrator for instructions. The Solitaire 
950 Database function automatically compacts the history database as part of the process. 

1. Click on Windows Start icon  on your PC. 

2. Choose DB Utilities from your Solitaire 950 group of icons and click on the icon . 

3. The following Login dialog box appears 

 

4. Log in with KABA ILCO (KABA as name and ILCO as password) if you have not already 
imported or created a database.  

OR 

5. Log in with the name of the Administrator you created after logging in to the Solitaire 950. 
After you have logged in, the logo below tells you are in the DB Utility. 
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6. Click on the Import ASCII button  on the main menu button bar. 

 

7. The following window appears: 

 

Note: An ASCII file may have the extension “.txt” but it can also have any extension you 
choose. In this case, it's a good idea to label database files something like the .dat above to 
remind you that it is a data file. 

File Formats 
The following information is needed by the Solitaire database: 

§ User ID 

§ Last Name, 

First Name 

§ Sequence Number  
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There are two basic types of data formats: alphanumeric and numeric.  Since the size of the 
record fields is static, the fields have to be filled with some character in case the data inside is 
smaller than the maximum value.  

for alphanumeric types spaces must be appended after the data (ex. Edmund.      )  

§ for numeric types zeroes must precede the data (ex...0032).  

The ASCII files formatted for import must be created by your database administrator and placed 
in a file so that you can import them into the Solitaire 950 database. 

For the detailed explanation on how to create these import.dat ASCII files (the detailed 
information may be required by your Database Administrator) see File Format Information for 
Database Administrators in the Annex to this document 

8. Select the file to import and the log. Select Display Log if you wish. 

9. Click on Import. 

10. When the import is complete, you will see messages like the ones below if you have selected 
Display Log.  

 

11. Open the Solitaire 950 application and you will see that the ASCII files you imported are now 
added to your list of Users. 
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Database Utilities - Transfer 900 Database 

HOW DO I IMPORT MY SYSTEM 900 DATABASE USING DB 
UTILITY)? 
A special import program lets you put data directly from System 900 into Solitaire 950 through the 
DB Utility. 

WARNINGS:   

1.  MAKE SURE YOU HAVE A CURRENT BACKUP OF YOUR SYSTEM 900 DATABASE 
before you import it into Solitaire 950. 

2.  When you import the system 900 database into Solitaire 950, all doors show as 
being updated (they appear with green lights). Therefore, BEFORE YOU IMPORT THE 
DATABASE, MAKE A NOTE OF ALL DOORS THAT NEED TO BE UPDATED so you can 
carry out the update in the Solitaire 950. Remember, if you don't write down which 
doors need to be updated you will lose that information 

3.  Before installing the application Solitaire 950, verify that your computer clock 
settings are correct and are set for the correct timezone. Failure to ensure that the 
date and time are correct on your PC may cause severe problems with the installation. 

 

HOW DO I IMPORT A SYSTEM 900 DATABASE? 

1. Click on Windows Start icon  on your PC. 

2. Choose DB Utilities from your Solitaire 950 group of icons and click on the  icon. 

3. Log in to the Database application. 

4. From the Main Menu button bar click on the Import System 900 database button . The 
following screen appears: 

 

5. Type in or browse for the System 900 database file location and select Display Log if you 
wish. Enter the location where you want the log. (The log permits you to see if there are 
problems with data transfer.) 

6. When ready to transfer, click on . 

7. You will see the following log describing the action as it occurs. The process may take time. If 
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you have a slower computer or a large database, please be patient and wait till the process is 
complete. 

 

8. During the time that the utility is importing the data, you will see a message asking you to wait 
until the process is complete. 

9. When the process is complete, a message appears in the bottom field of the dialog box 
shown below. 

 

10. Click on OK after you see a message informing you that the import process has terminated. 

Note: If you are upgrading from a previous KABA product (System 900, for example) you 
may import your database with all its Users. However, you cannot import administrators. You 
must create NEW Master Administrators and all the other levels of administrators - Levels 1, 
2, and 3. Of course you may use the same names and information but because it is a new 
system, the Administrators must be re-designated to their positions. 
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 Import ASCII files From Millenium 

You can now import a user database from the Millenium Access Control system directly into the 
Solitaire 950 system, making the transition between the two systems very smooth. 

To perform any database operations, you must open the separate file DB Utility application 
installed when the Solitaire 950 for Windows was installed. Database operations cannot be 
conducted from the program when it is running. 

Note: The database operations are for stand-alone Solitaire 950 software configurations. If 
your Solitaire 950 runs in a NETWORK configuration, DO NOT PERFORM THESE 
DATABASE OPERATIONS. See your database administrator for instructions. The Solitaire 
950 Database function automatically compacts the history database as part of the process. 

1. Click on Windows Start icon   on your PC. 

2. Choose DB Utilities from your Solitaire 950 group of icons and click on the icon . 

3. The following login dialog box appears 

 

4. Log in with kaba Ilco (kaba as name and Ilco as password) if you have not already 

imported or created a database. 

OR 

Log in with the name of the Administrator you created after logging in to the Solitaire 

950. The logo below tells you are in the DB Utility. 
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5. Click on the "Import files from Millenium" button on the main menu button bar .   

The following window appears: 

 

Note: An ASCII file may have the extension .txt but it can also have any extension you choose. In 
this case, it's a good idea to label database files something like the .dat above to remind you that 
it is a data file. 

File Formats 

The following information must be included in order for the Solitaire Database to import it 
successfully : User ID, Last Name, First Name and Sequence Number. There are two basic types 
of data formats: alphanumeric and numeric.  Since the size of the record fields is static, the fields 
have to be filled with some character in case the data inside is smaller than the maximum value.  
For alphanumeric types spaces are appended after the data (ex.: Edmund. ……) and for numeric 
types zeroes precede the data (ex.: .0032).  The ASCII files formatted for import must have 
already been created by you and placed in a file directory so that you can import them into the 
Solitaire 950 database. 

For the detailed explanation on how to create the import.dat ASCII files other than from 
Millenium-  see  page 171 -  File Format Information for Database Administrators. 

6. Browse for the file to import. 
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7. Click on Test Import first if you want to ensure that there are no errors in the file you are 
importing. 

8. Click on Import. 

When the import is complete, you will see messages like the ones below.  

 

9. Open the Solitaire 950 application, and you will see that the ASCII files you imported are now 
added to your list of users. 
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Restore a Database 

HOW DO I RESTORE MY PREVIOUS SOLITAIRE 950 
DATABASE? 
If you have to re-install the Solitaire 950 application, a special Restore program lets you put a 
backup of a previous database into the new Solitaire 950. To do this, you use the DB Utility 
following the procedure below. 

1. Click on Windows Start icon  on your PC. 

2. Choose DB Utilities from your Solitaire 950 group of icons and click on the icon . 

3. Log in to the Database application. 

4. From the Main Menu button bar click on the Restore database button . 

5. The following screen appears: 

.  

6.  Browse for the filename of the database you want to restore. 

7. Click on the Restore button. 

8. The following message appears when the restoration is complete. 

 

9. Click on OK after you see the message informing you that the import process has terminated. 

Note: If you are restoring from a previous Solitaire 950, the database will be restored exactly 
as it was. The various administrators still retain their status and any doors that need 
updating are still indicated. This is different from importing a database from a previous 
product such as the Solitaire 900 where you lose these attributes.  
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Chapter 8:  Reports 
In addition to the audit trail on each lock that records who entered or who tried to enter a room, 
the PC keeps a record of any transaction performed on it. The PC stores the previous 1000 
events and will allow you to view or print these transactions in a variety of categories. 

The PC audit trail prevents fraudulent use of the PC, even by those with valid operator 
passwords, by providing a complete picture of door access in a given time. All operators should 
know about this feature so that they are aware that each interaction with a lock (entering, exiting, 
etc.) is logged. You should make periodic printouts of the audit trails for your security records. 
The following reports can be run, viewed on screen, and printed: 

 

(The last item. under Valid Keycards, is All Keycards.) A description of each report is displayed in 
the report selection window. See also: Running a Report on page 165. 

.  
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Report Information 

HOW DO I INCLUDE COMPANY INFORMATION ON MY 
REPORTS? 
The information you enter here will appear at the top of any system reports you run. This 
information is entered using the following procedure. 

 

1. From the Main Menu bar, select Options, then Set Up>Workstation. 

2. The Configuration Window dialog box appears. 

3. Select the Company Info tab. 

4. Fill in your company name and address and click OK. 

Your company name and address will automatically appear on all reports you generate on any 
subject. 
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Running a Report 

HOW DO I RUN A REPORT? 

 

1. Click on the Report button  on the main toolbar, or select Reports from the File menu. 
The Reports dialog box appears as above. 

2. Choose the report you want to run from the list provided. A description of what you will see in 
the report appears under the list window. 

3. Click on Run Reports 

4. A Customizing Report dialog box appears. 

 

5. Select the field you want the report to sort by and then the fields for the report range (in the 
example above, from "A Shift" to "standard".) If you want a report on only one person or door 
in the range of fields, select the same item in From and To.  In the example below, you will 
only get a report on the user Cooper. 
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6. On the right of the dialog box, choose the percentage of the screen you want to use to view 
the report (75% usually enables you to view the whole page) and then click Preview, Print, or 
Export. Naturally, in order to print the report, you must have the correct printer drivers 
installed. 

Note: Doors by Users and Users by Doors are the two reports that will take the longest to 
compile because there could be a large amount of data to check. You may have to wait a 
few minutes before the Preview appears. 

7. Your preview screen should show a report like the example below. If there is no company 
identification on your report, follow the procedure in Report Information. 
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Note: The Export action involves other dialog boxes, which will appear sequentially, asking 
you to choose value separators, format and destination for the report. 

8. Select the format for the exported report. 

 

9. Select the destination you want to export the report into. 
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10. You have a wide choice of applications and document formats as the destinations. After 
selecting the destination format, you will choose the separator. Select the type of separator 
appropriate to the destination application (a colon in the example below). Some applications 
such as Microsoft Excel don't need separators for data, as the data appears in cells. 

 

 

Next, you can select the date and time formats for your report, or accept the formats built into the 
overall format you have chosen. This is mainly a question of preference for day/month/year or 
month/day/year. 

 

The next two pages provide two examples of commonly printed reports in common formats. 
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1. Access Group Timezone by Doors in Excel 5.0 
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1. Users in Word 5.0 
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Annex 

ASCII FILE FORMAT INFORMATION FOR DATABASE 
ADMINISTRATORS 
To import user information in Solitaire Electronic Lock Systems (Solitaire), an ASCII format is to 
be used for maximum flexibility and compatibility with the Solitaire 950 software. Any name can 
be used for the file, but for simplicity the name Import.dat is recommended.  The following 
information is the minimum needed by the Solitaire database: User Id, Last Name, First Name 
and Sequence Number.  In order to minimize the size of import file and to reduce the risks 
inherent to this kind of operation there are 3 types of operations on user records: 

 

RD, record delete; 

RM, record modify; 

RA, record add. 

 

These operations are used in a batch fashion.  For example, RD will be declared only once in the 
file with a number indicating how many records will be deleted.  The records that come after RD 
will be all deleted, their number should be same as the one declared after RD.  After that, the end 
of file or another operation may be placed. 

There are two basic types of data formats: alphanumeric and numeric. 

 

Note: In order to be backwards compatible with version 01.0000, the fields can be filled with 
some character in case the data inside is smaller than the maximum value.  When filling, for 
alphanumeric types, spaces must be appended after the data (ex. Ted ) and for numeric 
types, zeroes must precede the data (ex.: 0032). 

The date and time of creation and the file format version are the first data items in the file.  
After that, the three operations with their respective records are declared.  The version 
number is made of the high version number, a dot and the lower version number (ex. 
01.0000).  It corresponds to each version of file format, so in case the import file’s structure 
changes, it will be easy to implement a backward compatibility feature.  The version 
corresponding to this specification document is 01.2000.  The import format is the following: 

 

[Date]<TAB>[Time]<TAB>[Version]<CR><LF> 

[Record Operation]<TAB>[Number Records]<CR><LF> 

[User Id]<TAB>[Last Name]<TAB>[First Name]<TAB>[Sequence Number]<CR><LF> 

<EOF> 

 

 
 

 

Symbol Explanation: 
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 []   - inside the square brackets, there is data needed by the import process, in bold  
                             typeface for easier  recognition. 

<>              - inside these brackets there are special characters necessary for formatting. 

<TAB>  - Horizontal tabulation, hexadecimal value 0x09. 

<CR>  - Carriage Return,    hexadecimal value 0x0D. 

<LF>  - Line Feed,    hexadecimal value 0x0A. 

<EOF>  - End Of File,    hexadecimal value 0x04. 

 

Field Details 
Type explanation: 

Alpha (A) - Only ASCII alphabet letters, a-z, A-Z. 

Chars Any printable character, the following formats to be used for date and 
time: 

     DD     - day 

     MM     - month 

     YYYY   - year. 

     hh     - hour 

     mm     - minute 

     ss     - second 

Digits (N)  - Numbers, 0-9. 

 

The following fields are used in all Solitaire systems.  Please note that fill data is optional, is 
required only if compatibility with version 1.0 specification is needed. 

 

Fields common to all Solitaire systems: 
 

Field 
 

Format 
 

Type & Size Fill type Repeat 
 

[Date] YYYY-MM-DD 10 chars Zero Once, beginning of the file 

[Time] hh:mm:ss 8 chars Zero Once, after date. 

[Version] NN.NNNN 7 chars Zero Once, after time. 

[Record 
Operation] 

RD, RM or RA 
only 

2 alpha Space Every operation is declared 
once. 

[Number 
Records] 

NNNNNN 6 digits Zero Once for each type of 
operation 

 

Maximum values for various fields: 
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[Date]  - DD:  01 to 31 

               MM:  01 to 12 

               YYYY:  2000 to 2029 

[Time]   hh:   00 to 23 

   mm:   00 to 59 

   ss:   00 to 59 

[Version]  High version:   01 to 99 

                 Lower version: 0000 to 9999 

 

Please note that the present version is 01.2000 
[Record Operation] - RD, RM, RA 
[Number Records]  - 000000 to 999999 

 

System specific: 
The following fields are specific to Solitaire 950 system.  The only thing required is to respect the  
maximum length of the fields and the maximum values.  Filling the data is optional. 

Solitaire 950 
Field 
 

Format 
 

Type & Size Fill type Repeat 
 

[User Id] NNNNNNNNN 9 digits Zero Once per record 

[Last Name] AAA…AAA 19 alpha Space Once per record 

[First Name] AAA…AAA 19 alpha Space Once per record 

[Sequence 
Number] 

NNNN 4 digits Zero Once per record 

 

 

Maximum values for various fields: 

[User Id]   - 0 to 999999999 

[Last Name]   - Anything from a/A to z/Zs (19 characters) 

[First Name]   - Anything from a/A to z/Zs (19 characters) 

[Sequence Number]  - 0 to 9999 

 

 
 

 

The sequence number, if not used by the system, will be ignored, so it should be have the value 0 
for clarity.  Also, the fields can have any length and any value.  But if a field is too large for a 
certain system, the software will truncate the value it reads.  To avoid confusion, it is strongly 
recommended to respect the limits and maximum values described above. 
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In order to minimize problems that can be due to lack of space on hard drive, first place the delete 
operations, RD, at the beginning of the file with the update operations, RM, next and then, at the 
end, place your insert operations, RA. 

Examples of import files 
Here is an example of import files for Solitaire 950 to show how the sequence number is used.  
The examples illustrate also the filling of data, some fields are filled with zeroes or spaces and 
others are not. 

 

Solitaire 950: 

2005-01-25 10:47:30 01.2000 RD 000001 

123456789 Hutchins         Ted         1234 

RM 02 

999999999 Bates          Luke        9999 

00001235 Rivaldi           Antonia     0235 

RA 3 

123456 Leigh Bruce  1 

1234567 Chan              Jack 12 

12345678 Norris            Charlene    123 

 

12345678 Norris            Charlene          0 


